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Overview

Overview

This document is a compilation of enhancements made in Costpoint, Budgeting and Planning, and Time &
Expense from June 9 — August 31, 2018, and a few additional features that were released mid-September.

These enhancements were available in the non-production environment from October 9 — November 27, 2018.
They were be applied to the production environment on November 28, 2018.

Note: Release notes contain summaries of the enhancements made. Refer to the online help for additional details.

Costpoint 7.1.1 Online Help
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Delte

Platform Changes

Know more.
Do more.*

Platform Changes

New Costpoint 7.1.1 User Interface

Costpoint 7.1.1 has a new modern and intuitive user interface (Ul) with many enhancements.
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Changes to the Desktop

Improved User Interface and Navigation

The new Ul streamlines navigation and provides an improved user experience. Some of the updates include:

= A new Login screen with the option to use the new Ul or the classic view.

A responsive layout and optimized screen size.
Modernized menus, toolbars, and icons.

Redesigned lookup, query, messages, and dialog windows.

For more information:

View a Walkthrough of Costpoint’s new UlI.

Learn how to navigate the new Ul in the Costpoint Navigation video.

Refer to the Getting Started Guide for detailed descriptions of updated icons, dialogs, menus, and toolbars.

Refer to the Deltek Costpoint 7.1.1 New Ul FAQs for common questions about the new Ul.

Read Knowledgebase article #94430 to learn about the upcoming updates for Time and Expense 10.

The quick reference cards or QRCs found in the online help have also been updated to align with the new user interface.

Query and Lookup QRC

Setting Up Printers QRC

Shortcut Keys, Toolbar Icons, and Buttons QRC
Views QRC

The User Interface click-thru is also available to give you more information about the new Costpoint user interface.
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Do more.®
Platform Changes
Changes to the Mobile View
The new Ul is also available in the Costpoint mobile view.
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Accounting

There are no changes to the Accounting domain for this release.

Contracts

Patches Deployed for Future Enhancements
Patches were deployed for the following future enhancements:

= Manage Opportunities, Configure Opportunity Settings, Manage Opportunity Stages, and Manage DFARS
Library screens.

= Configure Opportunity Settings screen and for an upcoming new screen in the Contracts domain.
= Configure Contract Management Settings screen.

= Configure Opportunity Settings screen and for an upcoming new screen in the Contracts domain.

Contract Management Video and Click-Thrus

The Contract Management Overview video has been updated to reflect the new Ul and the change from the Contract
Management module to the new Contracts domain. See the latest video through this link: Contract Management
Overview.

Click-thrus have also been created to give you an overview about the main areas in the Contracts domain and assist
you as you work with these areas. Use the following links to access the click-thrus:

= QOpportunities Overview Click-Thru

=  QOrganizational Conflict of Interest Overview Click-Thru

= GovWin IQ Integration Overview Click-Thru

= Contracts Overview Click-Thru

= Subcontracts Overview Click-Thru

=  Customer, Vendor, and Employee Overview Click-Thru

User Options for Project Modification Effective Date: Phase II

Having accurate effective dates in project modifications is important since these dates determine which modifications will
be used in determining the amount of funding or contract value to be used in enforcing revenue ceilings. With the
system date as a default for effective dates of new modifications, which was the previous functionality, revenue ceilings
can be released prematurely if you are entering a future project modification. Although the date that defaults can be
edited, users may not notice that the date is incorrect and revenue ceilings could get released incorrectly.

To use more accurate effective dates for modifications when computing revenue, Costpoint now provides you the option
to default the system date for effective dates or to leave the effective date field blank so users would be required to
complete it.

Screen Updates

Several applications have been modified for this enhancement and rolled out in two releases.
In a previous release, changes to the following screens were included:
= Configure Project Settings (PJIMSETNG)

= Manage Modifications (PIMMOD)

Production Release Notes 4
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= Manage Project User Flow (PIMBASIC)
= Import Project Master Data (PJPPREP)
= Set Up Company (SYPCOMP)

In this Phase Il release, other applications with the Effective Date field have been updated.

Screens with the Effective Date Field

The Effective Date field on these screens now considers the option selected in the Modifications Effective Date group
box in Configure Project Settings:
= Manage Contracts (CTMCNTR), on the Modifications tab

= Manage Subcontracts (CTMSBCNTR), on the Modifications tab
= Manage Alternate Project Revenue Profiles (PIMALTPJ), on the Modifications subtask
= Manage Project Revenue Calculation Value History (PJMALTHS), on the Modifications subtask

Note: If Default System Date is selected on the Configure Project Settings screen, check that the
date that defaults is applicable to new project modifications to avoid revenue ceilings being released
incorrectly.

If User Must Enter Date is selected, make sure to enter a value in Effective Date before saving the
record to avoid an error.

Contract Management Reporting: Opportunity

Changes to the following applications have been rolled out in preparation for the future release of the new opportunity
reporting screens in the Contracts domain:

= Manage Opportunities — A new check box, Exclude from Reports, has been added to this screen to allow
you to indicate which opportunity records should be excluded from reports in the Contracts domain. This is
important when you need to generate reports and exclude certain types of opportunities (for example, indefinite
delivery/indefinite quantity and blanket purchase agreement opportunities) to avoid overstating the reports.

This application has also been modified to update the new Opportunity Audit table, OPP_VALUE_AUDIT, which
captures data from the Manage Opportunities screen as changes are made to certain fields. The values in the
audit tables will be used within trending reports within Costpoint Enterprise Reporting.

= Manage Opportunity Stages — The following columns are now available on this screen to help you filter and
group opportunity stages for reporting purposes:

= Grouped Stage Name — Enter the grouped stage name for reporting on opportunities.

= Include in Current Pipeline — Select this check box to include the opportunity stage in the current
pipeline.

= Win/Loss — Select the option where the opportunity stage should be included in pipeline reports and
analytics. Valid values are Win, Loss, and NA, with NA as the default value.

FAR and DFARS Updates

Enhancements have been made to the Manage DFARS Library screen to enable you to track other supplemental
regulation clauses/provisions in addition to Federal Acquisition Regulation (FAR) and Defense Federal Acquisition
Regulation Supplement (DFARS) clauses/provisions, and associate these clauses/provisions to contracts and
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subcontracts. Some subtasks on the Manage Contracts and Manage Subcontracts screens have also been updated
with additional fields that can provide adequate information about the clauses/provisions that apply to contracts and
subcontracts. This information can help you determine whether you have the correct version of the clause or provision.

Screen Updates

Manage Supplemental Regulations Library (CTMDFAR)

Previously named Manage DFARS Library, this screen is now labeled as Manage Supplemental Regulations Library to
cover clauses from both DFARS and other agencies.

A new column, Agency, is added to this screen, which you can use to enter the agency who issued the supplemental
regulatory clause. The DFARS Clause Number column has also been renamed to Clause Number.

Manage Contracts (CTMCNTR)
The following fields are now available on the FAR Clauses/Provisions subtask:

= Description from Contract — Enter the FAR clause/provision description from the contract.

= Page No — Enter the page number where the FAR clause/provision is located within the contract.

= Effective Date — Enter, or use calendar to select, the effective date of the FAR clause/provision.
These are the changes to the Supplemental Regulations subtask:

= Previously labeled as DFARS Clauses, this subtask is now named Supplemental Regulations to cover clauses
from both DFARS and other agencies.

= The following fields have been renamed:
= From Copy DFARS Clauses from to Copy Supplemental Regulations from
= From DFARS Clauses to Supplemental Regulations
= From DFARS Clause Number to Clause Number
= The new fields on this subtask include:
= Agency — Enter, or use lookup to select, the agency who issued the supplemental regulatory clause.
= Description from Contract — Enter the supplemental regulatory clause description from the contract.
= Page No — Enter the page humber where the supplemental regulatory clause is located within the contract.
= Effective Date — Enter, or use calendar to select, the effective date of the supplemental regulatory clause.
Manage Subcontracts (CTMSBCNTR)
The following fields are now available on the FAR Clauses/Provisions subtask:

= Send to PO — Select this check box if the FAR clause/provision should flow to the purchase order associated
with the subcontract.

= Description from Contract — Enter the FAR clause/provision description from the contract.

= Page No — Enter the page humber where the FAR clause/provision is located within the contract.

= Effective Date — Enter, or use calendar to select, the effective date of the FAR clause/provision.
These are the changes to the Supplemental Regulations subtask:

» Previously labeled as DFARS Clauses, this subtask is now named Supplemental Regulations to cover clauses
from both DFARS and other agencies.

= The following fields have been renamed:
= From Copy DFARS Clauses from to Copy Supplemental Regulations from

* From DFARS Clauses to Supplemental Regulations

Production Release Notes 6
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=  From DFARS Clause Number to Clause Number
=  The new fields on this subtask include:

= Send to PO — Select this check box if the regulatory clause should flow to the purchase order associated
with the subcontract.

= Agency — Enter, or use lookup to select, the agency who issued the supplemental regulatory clause.
= Description from Contract — Enter the supplemental regulatory clause description from the contract.
= Page No — Enter the page number where the supplemental regulatory clause is located within the contract.

= Effective Date — Enter, or use calendar to select, the effective date of the supplemental regulatory clause.

Viewing Additional Reports in the Contracts Domain

Some changes have been made available on the following screens in preparation for future enhancements in the
Contracts domain:

=  Configure Opportunity Settings

= Addition of parameter settings so that Project Labor Summary Report and Project Non-Labor Detail
Report can be run from Manage Opportunities

= Manage Opportunities

= Addition of Project Labor Summary Report and Project Non-Labor Detail Report to the Print and
Preview menu selections on the Projects Linked subtask

= Change of subtask name from Opportunity Teammates to Opportunity Teammates/Competitors

= Change of field name from Prime/Subcontractor to Teammate/Competitor, and addition of Competitor to
the drop-down list

= Manage Contracts

= Addition of Project Labor Summary Report and Project Non-Labor Detail Report to the Print and
Preview menu selections on the Projects Linked subtask

= Manage Subcontracts

= Addition of Project Labor Summary Report and Project Non-Labor Detail Report to the Print and Preview
menu selections on the General tab

Note: Although these changes are already available on the screens, they have no impact on the current functionality
yet. A future version of Costpoint will be required for these fields to take effect.

Contract and Subcontracts

Costpoint now provides you the ability to generate reports in the Contracts domain, which can help you determine if
decisions need to be made regarding a contract or subcontract. These reports provide contract and subcontract details
including but are not limited to the following:

= Total award and percent complete values

= Task orders that have been assigned to specific vehicles

= Expiration dates of non-disclosure agreements and certificate of insurance
= Contract types and end dates

You have various options for grouping and sorting the data in the reports. You can also include inactive contracts and
subcontracts.
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Four new applications have been created to support this enhancement, while two existing screens were recently
updated. In a previous release, a new check box (Exclude from Reports) was added to Manage Contracts and
Manage Subcontracts to allow you to exclude certain contracts and subcontracts from reports generated in the
Contracts domain.

Screen Updates

Print Contract Backlog Report (CNRBKL)

Use this new screen to print the Contract Backlog Report. This report displays the percent complete funding values and
revenue for the contracts in the selected range of prime contract numbers, contract vehicles, and contract types. You
can use this information in determining how much money is left on each contract and whether action needs to be taken
due to contract overruns.

You can sort the data in the report by contract end date and contract vehicle as well as include inactive contracts. There
is an option to select either the target or actual rate, which is used to display actual or target revenue or percent
complete funding.

To access the screen, go to Contracts » Contracts » Contract Reports and Inquiries » Print Contract Backlog
Report.
Print Contracts by Administrator Report (CNRADM)

You can now print contract information by contract administrator through this new screen. The Contracts by
Administrator Report lists all the contracts sorted by contract administrator in the selected range of contract statuses,
contract types, and contract vehicles. It includes information on awarded and funded contract values, task order
numbers, and risk status. You can use this report to assess the responsibilities and workload of the contract team.

The report can include inactive contracts and can be sorted by administrator ID or name.

You can access the screen by clicking Contracts » Contracts » Contract Reports and Inquiries » Print Contracts by
Administrator Report.
Print Contract Vehicle Report (CNRVEH)

This new screen allows you to print a list of contracts grouped by contract vehicle in the selected range of vehicle codes,
contract statuses, contract types, and primary customers. The task orders assigned to contract vehicles as well as
contract and funded values are also included in the report.

Data in the report is automatically sorted by vehicle code, but you have options to include additional sorting option levels
by contract end date, status, and/or type. You can also include inactive contracts.

To access this application, click Contracts » Contracts » Contract Reports and Inquiries » Print Contract Vehicle
Report.
Print Vendor COI & NDA Expiration Report (CNREXP)

Use this new application to print a report containing expiration dates of subcontractor certificate of insurance (COI) and
non-disclosure agreement (NDA) documents associated with subcontractors.

By default, the report is sorted by subcontractor/vendor ID, but you can select NDA expiration date or COI expiration
date as the second sorting level.

You can access this screen through Contracts » Contracts » Subcontract Reports and Inquiries » Print Vendor COI
& NDA Expiration Report.

New Contracts Domain: Change to Import GovWin IQ Data

In a previous release, the Contract Management module under the Projects domain was changed to a separate
Contracts domain. With this change, new modules were created and several applications within the Contract
Management solution were moved to these new modules.

The Import GovWin IQ Data application was among those that were transferred to the Opportunities module. However,
access to this application was retained under the Contract Management Controls module.
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In this release, the access rights to this screen is now under Opportunities. Make sure that you check if your users and
user groups are assigned the correct application rights through the Manage Users and Manage User Groups screens in
the Admin domain.

GovWin IQ Subtask Updates

Several new fields have been added and changed on the GovWin 1Q subtask of Manage Opportunities to allow you to
modify entries in some of the fields and sort data based on milestone dates, GovWin IQ login ID, and employee ID. The
application logic has also been updated when matching the employee ID with the employee’s GovWin IQ login ID.

More details are listed below:
=  GovWin IQ Key Dates subtask
= The Comments and Responsible Party fields are now editable.
= You can now sort data by Milestone, Date (IQ Estimate), Comments, and Responsible Party.
=  GovWin IQ Added By subtask

= Anew field, GovWin IQ ID, has been added. For GovWin IQ records, this field displays the GovWin IQ
login ID of the employee who marked the opportunity in GovWin 1Q for import into Costpoint. For Manual or
new records, click lookup to select the GovWin 1Q login ID of the employee who also recommended the
opportunity but did not tag the opportunity record in GovWin IQ. The GovWin IQ ID is mapped to the
employee on the Product Interface tab of Manage Employee Information.

= The Name field has been split to First Name and Last Name to display the employee’s first and last names
in separate columns. These fields are editable only for Manual records.

= You can now sort data by GovWin 1Q ID, First Name, Last Name, Employee ID, and Source.

=  When importing GovWin IQ records, the system will match the user login ID in GovWin IQ to a Costpoint
employee using the following logic:

1. Costpoint matches the GovWin IQ login ID (email address used for login) to the Costpoint field
EMPL.GOVWINIQ_LOGIN_ID.

If not found, Costpoint matches the GovWin IQ login ID to EMPL.EMAIL_ID.

3. If still not found, Costpoint matches the first name and last name from GovWin IQ to the
EMPL.FIRST_NAME and EMPL.LAST_NAME fields in Costpoint.

4. |If still not found, the Employee ID field on the GovWin IQ Added By subtask is left blank and non-
editable.

Ability to Exclude Contracts and Subcontracts from Reports

A new check box, Exclude from Reports, has been added to the Manage Contracts and Manage Subcontracts screens
to allow you to indicate which contract/subcontract records should be excluded from reports in the Contracts domain.
This is important when you need to generate reports and exclude certain types of contracts (for example, indefinite
delivery/indefinite quantity and blanket purchase agreement contracts or subcontracts) to avoid overstating the reports.

Note: This change has been rolled out in preparation for the future release of the new reporting screens in the Contracts
domain.

Projects

User Options for Project Modification Effective Date: Phase I
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Having accurate effective dates in project modifications is important since these dates determine which modifications will
be used in determining the amount of funding or contract value to be used in enforcing revenue ceilings. With the
system date as a default for effective dates of new modifications, which was the previous functionality, revenue ceilings
can be released prematurely if you are entering a future project modification. Although the date that defaults can be
edited, users may not notice that the date is incorrect and revenue ceilings could get released incorrectly.

To use more accurate effective dates for modifications when computing revenue, Costpoint now provides you the option
to default the system date for effective dates or to leave the effective date field blank so users would be required to
complete it.

Screen Updates

Several applications have been modified for this enhancement and will be rolled out in two releases.
In this Phase | release, the following applications have been updated.

Configure Project Settings (PJMSETNG)

The new Modifications Effective Date group box added to this screen contains the following fields:

= Default System Date — Select this option to have Costpoint use the system date as a default for the effective
date of new project modifications. The date that defaults can still be changed when you select this option.

= User Must Enter Date — Select this option to require the user to enter the effective date when entering new
project modifications. No date defaults when you select this option, and the user must enter a date before
he/she can save the modification record.

Manage Modifications (PJMMOD) and Manage Project User Flow (PJMBASIC)

The Effective Date field on these screens now considers the option selected in the Modifications Effective Date group
box in Configure Project Settings:

= Manage Modifications (PIMMOD), in the Modifications group box
= Manage Project User Flow (PJIMBASIC), on the Modifications subtask

Note: If Default System Date is selected on the Configure Project Settings screen, check that the
date that defaults is applicable to new project modifications to avoid revenue ceilings being released
incorrectly.

If User Must Enter Date is selected, make sure to enter a value in Effective Date before saving the
record to avoid an error.

Import Project Master Data (PJPPREP)

This application has been updated to consider the option selected in the Modifications Effective Date group box in
Configure Project Settings when importing project modifications. It uses the following logic:

= If Default System Date is selected and there is no Effective Date value (EFFECT_DT column in the
PROJ_MOD table) in the input file, the system date defaults into the modification effective date when project
modifications are imported.

= If Default System Date is selected and an Effective Date value has been entered in the input file, Costpoint
uses the input file effective date when project modifications are imported. The system does not overwrite this
date with the current date.
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= |f User Must Enter Date is selected, the input file must have an Effective Date value before it can be imported.
If Effective Date is left blank, an error will be indicated in the Import Project Information Error Report.

Set Up Company (SYPCOMP)

Set Up Company has been modified to include the selection made in the Modifications Effective Date group box in
Configure Project Settings when copying settings from one company to another.

Add Subcontract ID to Project Modifications

Costpoint now gives you the ability to add subcontract IDs to project modifications so that you can see project
modifications entered by finance on your subcontracts. Several updates have been made on the following screens for
this enhancement.

Screen Updates
Manage Modifications (PJMMOD)
Changes to the Subcontract ID field includes the following:
= Previously named Subcontract, this field is now labeled Subcontract ID.

= Previously under Identification, the Subcontract ID field along with the Subcontract Name field are now in the
Modifications group box.

= If you are licensed for Contract Management:

= This field is enabled if the Subcontract Modification ID field is blank. You can enter or use lookup to select
a subcontract ID from a subcontract record created in the Contracts domain. Once you enter a subcontract
ID for the project modification and save the record, this project modification becomes visible for the
subcontract ID on the Manage Subcontracts screen.

= This field is disabled if the Subcontract Modification ID field is not blank, and you will not be able to enter
or modify the subcontract ID.

Note: The Subcontract Modification ID field is visible only if you are licensed for Contract
Management.

= If you are not licensed for Contract Management, you can enter a subcontract ID in this field, but this will not be
validated by the system.

Several other updates have been made to this screen, as follows:

= The Contract field is now labeled Contract ID and has also been moved, together with the Contract Name
field, to the Modifications group box.

= [If a contract ID exists for the project entered on this screen, that contract ID defaults in the Contract ID field
upon tabbing out of the Project field. Previously, the contract ID displays only after saving the record.

= The Contract ID, Contract Name, Subcontract ID, and Subcontract Name fields are now visible whether or
not you are licensed for Contract Management.

Note: The Contract Modification ID and Subcontract Modification ID fields remain hidden if you are
not licensed for Contract Management.
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Manage Project User Flow (PJMBASIC)
The Modifications subtask of Manage Project User Flow now has the following fields:

= Contract ID

= Contract Name

=  Subcontract ID

=  Subcontract Name

The Subcontract ID field on this subtask follows the same logic as the Subcontract ID field on the Manage Modifications
screen:

= If you are licensed for Contract Management:

= This field is enabled if the Subcontract Modification ID field is blank. You can enter or use lookup to select a
subcontract ID from a subcontract record created in the Contracts domain. Once you enter a subcontract ID
for the project modification and save the record, this project modification becomes visible for the subcontract
ID on the Manage Subcontracts screen.

= This field is disabled if the Subcontract Modification ID field is not blank, and you will not be able to enter or
modify the subcontract ID.

Note: The Subcontract Modification ID field is visible only if you are licensed for Contract
Management.

= If you are not licensed for Contract Management, you can enter a subcontract ID in this field, but this will not be
validated by the system.

For the Contract ID, if a contract ID exists for the project entered in the Identification group box of this screen, that
contract ID defaults in the Contract ID field on the Modifications subtask upon tabbing out of the Project field.
Previously, the contract ID displays only after saving the record.

Import Project Master Data (PJMMOD)
A new column, SUBCNTR_ID, has been added to the PROJ_MOD table.

If the user is licensed for Contract Management, the value that populates this column must exist in Manage
Subcontracts (SUBCNTR_ID column in the SUBCNTR_MASTER table). When the subcontract ID is imported from
SUBCNTR_MASTER, the project maodification linked to that subcontract ID becomes visible on the Manage
Subcontracts screen but remains in PROJ_MOD.

If the user is not licensed for Contract Management, the value in this column is not validated.

PJGOVTLIB and PJMODLIB Libraries

The PJGOVTLIB library contains common business logic, which is shared by the following applications:
= Manage Government Contract Information (PIMGOVT)
= Manage Project User Flow (PIMBASIC)

The PIJMODLIB library contains common business logic, which is shared by the following applications:
= Manage Alternate Projects (PJIMALTRP)
= Manage Contracts (CTMCNTR)
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= Manage Modifications (PIMMOD)
= Manage Project User Flow (PIMBASIC)
= Manage Subcontracts (CTMSBCNTR)

Include Variance Amounts in the Statement of Indirect Expenses

A new Variance column has been added to the Statement of Indirect Expenses (SIE) so you can know the difference
between actual and budgeted amounts and determine where you are missing budgeted numbers that could account for
a higher than expected indirect rate. Variance amount is calculated as Budget amount — Actual amount.

To display this column, you must select the new Show Variance Column check box on the Compute/Print Pool Rates
screen and select from the following options:

= Current Period — Select this option to display variance amounts in the current period. When you select this
option, the Variance column is displayed under Current Period on the SIE, together with the Actual and Budget
columns.

= Year To Date — Select this option to display year-to-date variance amounts. When you select this option, the
Variance column is displayed under Year To Date on the SIE, together with the Actual and Budget columns.

Note: The Year To Date Budget column is hidden when you select Current Period, and the Current
Period Budget column is hidden when you select Year To Date.

People

Costpoint Team Management Phase II

This Costpoint Team Management module enhancement moves the Team Management setting from the Configure
Personnel Settings screen to a new application, Configure Team Management Settings. The Team Management
settings allow you to specify if managers will be able to view the records of direct reports only, or of both direct and
indirect reports, in Team Management applications. All applications in Team Management will reference the setting in
the Configure Team Management Settings screen.

Note: This Costpoint release only includes the functionality to specify if managers can view
direct/indirect reports in Team Management applications. The additional features mentioned in the
updates for Configure Team Management Settings screen will be available in the Phase Il release of
Team Management enhancements.

Screen Updates

Address (HTMADDRESS)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.
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Citizenship (HTMCITIZENSHIP)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Company Property (HTMPROPERTY)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Configure Team Management Settings (HTMSETTINGS)

The Configure Team Management Settings screen will allow you to set up different options in the Team Management
module. You will now use this screen to specify if managers can only view data for just their direct reports or if they can
view data for both direct and indirect reports.

Change Options Subtask

Warning: The settings in the Change Options subtask of the Configure Team Management Settings screen are not yet
available in this release (Phase Il). This subtask will be fully functional in the Phase Il release of Team Management
enhancements.

The Configure Team Management Settings screen contains a Change Options subtask that provides the following
additional options for the Company Property, Phone/Email, Emergency Contacts, and Address applications:

= Require HR Approval for Changes — This check box allows you to specify if HR approval is required for any
change requests or changes made to an employee record by a manager (change/add/delete). If approval is
required, any change requests generated from that application will be saved to a holding table instead of being
inserted into the actual Employee table. If HR approval is not required, no change request will be created, the
change will instead be saved directly to the appropriate Employee table.

= Email HR Manager upon Change — This check box allows you to generate email notifications to an HR
manager if a change occurred in an application. Companies that use Costpoint Personnel module can either
select to email the appropriate HR manager for the employee or use a default email address. Companies that
do not use Costpoint Personnel module will only have the default option available to them.

= HR Email Method — This field allows you to specify how HR Administrators will be notified by email. This field
is only available if you select the Email HR Manager upon Change check box.

= Default HR Email Address — This field allows you to specify a default email address for the HR
representative. This email address will be sent an email if a manager makes a change to an employee record.
This field is only available if you select Default Email in the HR Email Method drop-down list.

= Email Manager upon Approval/Rejection — This setting sends an email the manager who initiated the
change request when the HR manager either approves or rejects the change request. Currently all email
messages in the natifications (both HR manager and change request manager) are generic system messages.
In the future, we may want to consider allowing users to customize those messages in the configuration
application.

= Warning: The settings in the Change Options subtask of the Configure Team Management Settings screen are
not yet available in this release (Phase Il). This subtask will be fully functional in the Phase Il release of Team
Management enhancements.

Configure Personnel Settings (HPMSET)

The Team Management setting, which allows you to specify if managers can view direct reports only, or both direct and
indirect reports, is no longer available on this screen. The setting moved to the new Configure Team Management
Settings screen which contains settings specifically for Team Management module.

The screen also contains the following changes:
= The Managers, Accident Claims, and Required Forms Upload group boxes were removed.

= The following options will longer be available in a group box:
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= Manager Defaulting Method
= Accident Claim Numbering Method
= Required Forms File Type
= The Required Forms File Type label replaces the Required Forms Update group box.
= The Training group box and Default Job Title Validation Method options were removed.
= The By Company-Wide Organization option label was corrected.
= The option label changed from “Claim Numbering Method” to “Accident Claim Numbering Method.”
= The check box title changed from “Require Org ID” to “Require Organization ID (Talent Management).”

Emergency Contacts (H-TMEMERGENCYCONTACT)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Government Documents (HTMGOVDOCUMENTS)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Knowledge (HTMKNOWLEDGE)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports; or direct and indirect reports.

Leave (HTMLEAVE)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Life Events (HTMLIFEEVENTS)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Phone/Email (HTMPHONE)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Set Up Company (SYPCOMP)

The new field from Configure Team Management Settings screen, Team Management view reports method, was added
into company defaults.

Team Details (HTMDETAIL)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Team Information Report (HTRTEAMINFO)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Total Compensation and Benefits (HTMTOTALCOMP)

The application now references the setting from the new Configure Team Management Settings screen which defines
the Team Management method for displaying either only direct reports, or both direct and indirect reports.

Use Format 3 for Employee History File Exports to Deltek Time and Expense 10+
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This Costpoint release updates the Export Data to Deltek Time and Expense (LDPDTC) screen to use version 3 format
when exporting Employee History information to Deltek Time & Expense version 10.x+ or greater.

Prior to this release, when exporting Employee History data, the application used the version 2 format for employee
records, and the version 3 format for subcontractor records. With this enhancement, the application will use the version
3 format for both employee and subcontractor records in the Employee History file.

Note: Deltek Time and Expense can process an Employee History file with employee records that
use the version 2 format and subcontractor records that use the version 3 format. However, if you
export both employee and subcontractor records to Deltek Time and Expense, Deltek recommends
that you apply this enhancement so that the same format will be used for both types of records.

When generating the Employee History file, the Export Data to Deltek Time and Expense screen performs the following
if the login company uses Time & Expense 10.x+ (or greater) as the Deltek Time and Expense version in the Corporate
Labor Settings subtask of the Configure Labor Settings screen:

= Populate Field 1 (Format Version) of the employee EMPL_HISTORY records with “3”
= Populate the following fields of the employee EMPL_HISTORY records with a NULL value:
*  Field 25 (Default UDT11)
= Field 26 (Default UDT12)
= Field 27 (Default UDT13)
= Field 28 (Default UDT14)
* Field 29 (Default UDT15)

Allow Updating of Organization IDs on Job Templates

This Costpoint release will allow you to modify the Organization IDs on existing job templates. In order to implement the
enhancement, the Organization ID will no longer be the primary key of job templates.

Screen Updates
The release updates the following screens for this enhancement:
Approve Position Requisitions (HPMAREQ)
= The organization ID was removed from the primary key of job templates.

= A new Original ID field displays the original job template ID. This field will only be populated if there was
previously another record in the table with the same ID.

=  When you use the Query function, the Find and Query tab now allows you to search for job templates using the
Original ID field.
Configure Personnel Settings (HPMSET)

A new Require Org ID check box allows Deltek Talent Management users to either require or not require the
Organization ID on the job templates for a company.

Note: This check box is enabled only when you have a Deltek Talent Management license. If you opted to clear the
Require Org ID check box, and then you stopped using Deltek Talent Management, you must manually select this check
box to require organization IDs on job templates.
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Manage Employee Information (LDMEINFO)

When creating employees through SilkRoad or Talent Management, and when searching for a job template, the
application uses the original ID for the job template as the job template ID. If the original ID does not exist, the
application uses the job template ID.

Manage Job Templates (HPMREQR)

The following are updates to the Manage Job Templates screen:
= The organization ID was removed from the primary key of job templates.
= The Organization ID field can now be edited.

= Anew Original ID field displays the original job template ID. This field will only be populated if there was
previously another record in the table with the same ID.

The company ID is now part of the primary key of job templates. Previously, the application performs a
validation to ensure that each job template ID was unique to a company ID.

Setup Company (SYPCOMP)

When you create a new company, the application applies a default value of Y to new Require Org ID field on the
Configure Personal Settings application (HP_PER_ADM_SETTINGS.ORG_REQ_FL).

Transfer SilkRoad Data (LDPSRDAT)

When searching for an existing job template ID (H_POS_RQ_RQST.RQ_NO), the application determines if it exists for
the employee’s company. If not, the application searches the Original ID field (H_POS_RQ_RQST.ORIG_RQ_NO).

When transferring the job template information to SilkRoad, if data exists in the Original ID field, the application sends
that ID number instead of the job template ID.

Transfer Talent Management Data (EMPHRSDAT)

When searching for an existing job template ID (H_POS_RQ_RQST.RQ_NO), the application determines if it exists for
the employee’s company. If not, the application searches the Original ID field (H_POS_RQ_RQST.ORIG_RQ_NO).

When transferring the job template information to Deltek Talent Management, if data exists in the Original ID field, the
application sends that ID number instead of the job template ID.

Known Issue
Newly Created Company Inherits the Auto-Approve Position Requisition Value of Login Company
Deltek Defect Tracking Number: 967206

Description: When you log in to Costpoint using a company with a default approver on the Configure Personnel
Settings screen (the Auto-Approve Position Requisitions check box was selected and a valid Default Requisition
Approver was specified), and then you create a new company, the created company inherits the login company's Auto-
Approve Position Requisitions (REQ_AUTO_APPRVL_FL) column value in the H_PER_ADM_SETTINGS table.

Customers Impacted: This defect affects Costpoint Personnel users.

Workaround Before Fix: Set up an approver on the Manage Position Requisition Approvers screen, and then use the
approver on the Configure Personnel Settings screen.

Additional Notes: None.
Allow Updating of Organization IDs on Job Templates

This Costpoint release will allow you to modify the Organization IDs on existing job templates. In order to implement the
enhancement, the Organization ID will no longer be the primary key of job templates.
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Screen Updates
The release updates the following screens for this enhancement:
Approve Position Requisitions (HPMAREQ)
= The organization ID was removed from the primary key of job templates.

= A new Original ID field displays the original job template ID. This field will only be populated if there was
previously another record in the table with the same ID.

=  When you use the Query function, the Find and Query tab now allows you to search for job templates using the
Original ID field.
Configure Personnel Settings (HPMSET)

A new Require Org ID check box allows Deltek Talent Management users to either require or not require the
Organization ID on the job templates for a company.

Note: This check box is enabled only when you have a Deltek Talent Management license. If you opted to clear the
Require Org ID check box, and then you stopped using Deltek Talent Management, you must manually select this check
box to require organization IDs on job templates.

Manage Employee Information (LDMEINFO)

When creating employees through SilkRoad or Talent Management, and when searching for a job template, the
application uses the original ID for the job template as the job template ID. If the original ID does not exist, the
application uses the job template ID.

Manage Job Templates (HPMREQR)

The following are updates to the Manage Job Templates screen:
= The organization ID was removed from the primary key of job templates.
= The Organization ID field can now be edited.

= Anew Original ID field displays the original job template ID. This field will only be populated if there was
previously another record in the table with the same ID.

The company ID is now part of the primary key of job templates. Previously, the application performs a
validation to ensure that each job template ID was unique to a company ID.

Setup Company (SYPCOMP)

When you create a new company, the application applies a default value of Y to new Require Org ID field on the
Configure Personal Settings application (HP_PER_ADM_SETTINGS.ORG_REQ_FL).

Transfer SilkRoad Data (LDPSRDAT)

When searching for an existing job template ID (H_POS_RQ_RQST.RQ_NO), the application determines if it exists for
the employee’s company. If not, the application searches the Original ID field (H_POS_RQ_RQST.ORIG_RQ_NO).

When transferring the job template information to SilkRoad, if data exists in the Original ID field, the application sends
that ID number instead of the job template ID.

Transfer Talent Management Data (EMPHRSDAT)

When searching for an existing job template ID (H_POS_RQ_RQST.RQ_NO), the application determines if it exists for
the employee’s company. If not, the application searches the Original ID field (H_POS_RQ_RQST.ORIG_RQ_NO).
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When transferring the job template information to Deltek Talent Management, if data exists in the Original ID field, the
application sends that ID number instead of the job template ID.

Regulatory and Compliance
2018 Oregon W-2 Electronic Filing

The new statewide transit tax for the State of Oregon, which took effect on July 1, 2018, must be reported in the RS and
RV records of the State’s W-2 file. In order to track the new tax, this release adds a new Transit Tax option to the Tax
Type drop-down list on the Manage Local Taxes screen.

When you set up the statewide transit tax for Oregon (State is Oregon and Tax Type is Transit Tax), then the local
taxable wages and local tax withheld will be reported as the state taxable wages for statewide transit tax and statewide
transit tax withheld, respectively, in the following records of Oregon's W-2 file:

RS Record

= Positions 348-358: Taxable wages for the statewide transit tax. Deductions that can be applied to wages for
income tax withholding generally cannot be applied to wages subject to the transit tax.

= Positions 359-369: Amount withheld for the statewide transit tax.
RV Record

= Positions 40-54: Total amount of taxable wages for the transit tax.

= Positions 55-69: Total amount of statewide transit tax withheld.

Warning: This Costpoint release only updates the Manage Local Taxes screen to allow you to track the new state
transit tax. The updated Create State W-2 File screen which will include the new state transit tax in Oregon’s W-2 file will
be released separately.

2018 New Jersey Withholding Tax

The State of New Jersey issued updated withholding tables, effective September 1, 2018, which implements a new
withholding rate of 15.6 percent for incomes of at least $5 million regardless of the taxpayer’s filing status. This release
adds new records for New Jersey in the following screens so that the taxes of this State will be calculated accurately in
Costpoint Payroll:

= Manage State Tax Withholding Adjustments
= Manage State Standard Deductions

= Manage State Tax Tables

2018 Maryland Withholding Tax

The State of Maryland released a revised withholding guide which reflects changes to the state's standard deduction for
the 2018 tax year. Maryland’s maximum standard deduction increases from $2,000 to $2,250.

Costpoint will be using the new maximum standard deduction amount for Maryland payroll. In order to accomplish this,
this Costpoint release adds new records, effective July 1, 2018, for Maryland in the Manage State Standard Deductions
and Manage Local Standard Deductions screens.

Attention: For more information, please refer to the Maryland Employer Withholding Guide:
http://forms.marylandtaxes.gov/current_forms/Withholding_Guide.pdf.

2018 New Mexico Withholding Tax
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This release updates Costpoint to support the following changes to the New Mexico withholding tax:
= The State’s tax brackets were updated.
= The amount per allowance increases from $4,050 to $4,150.

= When calculating New Mexico state tax withholding for an employee, if that employee claims more than three
allowances on his/her W-4, only three of the allowances will be applied.

Note: In order to apply this change, New Mexico exemption amounts were moved from the Manage State Taxes screen
to the Manage State Tax Withholding Adjustments screen where the transferred exemptions have an exemption type of
Personal Exemption Allowances in the Type field.

2018 New Mexico Withholding Tax

This release updates Costpoint to support the following changes to the New Mexico withholding tax:
= The State’s tax brackets were updated.
= The amount per allowance increases from $4,050 to $4,150.

= When calculating New Mexico state tax withholding for an employee, if that employee claims more than three
allowances on his/her W-4, only three of the allowances will be applied.

Note: In order to apply this change, New Mexico exemption amounts were moved from the Manage State Taxes screen
to the Manage State Tax Withholding Adjustments screen where the transferred exemptions have an exemption type of
Personal Exemption Allowances in the Type field.

2018 Kentucky Withholding Tax

Kentucky's withholding tax formula was updated to reflect the recently enacted 5% flat tax rate. In relation to the change,
this release updates Costpoint so that the 2018 withholding tables reflecting the 5% flat tax rate will be used in payroll.
The following are updates to the existing records for Kentucky, effective January 1, 2018, on the Manage State Taxes
screen and Manage State Tax Tables screen.

=  The withholding formula was updated to use a 5% flat tax rate.

= The exemption credit of $10 was removed.

Attention: For more information, please refer to the following link on the Kentucky Department of Revenue website:
https://revenue.ky.gov/Forms/42A003%20(TCF)%202018%20Withholding%20Tax%20Formula%20(Released%20May
%202018).pdf

2018 Q3 July SUTA Electronic Filing Updates

This Costpoint release includes enhancements to support the 2018 SUTA electronic filing updates of Alaska and Florida.

Alaska

The State of Alaska updated the Occupational Coding Manual for 2018. This release updates the Costpoint database
tables for Alaska Geographic Code (S_AK_GEO_CD) and Alaska Occupational Code (S_AK_OCC_CD) to reflect the
2018 coding changes.

This release also adds new validations on the Create Quarterly SUTA Tax File (PRPSMM) screen to ensure that there
are no invalid or missing codes when you create the tax file for Alaska.
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Florida

The Florida Department of Revenue released an updated reemployment tax specification (Schema v2018 1.0) last
March 2018. In order for Costpoint to be compliant with Florida's requirement, this release updates the Create Quarterly
SUTA Tax File screen to use the latest XML Schema for the State of Florida.

Materials Management

Organizational Security — Sales Order Entry

The Organizational Security feature enhances the secure functionality of Costpoint by warranting proper user access
throughout the Materials domain, specifically in the Sales Order Entry module. This feature ensures that correct user
access is applied to the logged-in user ID in accessing inventory transactions by validating and filtering
records/transactions as authorized for the user ID.

Organizational Security - Inventory

The Organizational Security feature enhances the secure functionality of Costpoint by warranting proper user access

throughout the Materials domain, specifically in the Inventory module. This feature ensures that correct user access is
applied to the logged-in user ID in accessing inventory transactions by validating and filtering records/transactions as

authorized for the user ID.

Administration Domain

This section includes summaries of the changes made in relation with the Organization Security feature within the
Costpoint Administration domain.

View Help About (SYMABOUT)

The Features subtask on the View Help About (SYMABOUT) screen now includes the Organization Security feature for
the Inventory module.

Materials Domain

This section includes summaries of changes made in relation with the Organization Security feature within the Costpoint
Materials domain.

Manage Sales Orders (OEMNTSO1)
The following are the changes to this screen:

=  Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s authorization of
the organization ID (new). In addition, Costpoint will not display sales orders where organization are left blank.

= Lookup

= Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID.

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations (standard
material) with organizations, and project (owning organization) authorized for the logged-in user ID.

= Document — Costpoint now narrows the search and displays only documents that are linked to
organizations authorized for the logged-in user ID. Costpoint also displays documents that are not linked to
any organization.

= Anew field, Organization, has been to the screen. Use this field to enter an organization ID for the sales order.
This field is required if the Organization Security feature is enabled.
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= Costpoint now validates your selected/entered entries in several fields against your logged-in user ID’s
organization and project’s owning organization rights.

= Approval Process (when approval process is enabled and you submit sales orders (SO) for approval) — IF you
add an approval process/approval title, at least one of the users for each approval title(s) must be authorized for
the organization ID.

= If none of the users for any of the approval titles in the approval process is authorized for the organization ID
(new), Costpoint displays an error message.

= |If at least one of the users for the approval titles in the approval process is authorized for the organization ID
(new), Costpoint displays a warning message.
Manage Sales Order Supervisor Screen (OEMNTSO2)
The following are the changes to this screen:

= Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s authorization
for the organization ID (new). In addition, Costpoint will not display sales orders where organizations are left
blank.

= Lookup

= Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations (standard
material) with organizations, and projects (owning organization) authorized for the logged-in user ID.

= Document — Costpoint now narrows the search and displays only documents that are linked to
organizations authorized for the logged-in user ID. Costpoint also displays documents that are not linked to
any organization.

= Anew field, Organization, has been added to the screen. Use this field to enter an organization ID for the sales
order. This field is required if the Organization Security feature is enabled.

= Costpoint now validates your selected/entered entries in several fields against your logged-in user ID's
organization and project’'s owning organization rights.

= Approval Process (when approval process is enabled and you submit sales orders for approval) — If you add an
approval process/approval title, at least one of the users for each approval title(s) must be authorized for the
organization ID.

= If none of the users for any of the approval titles in the approval process is authorized for the organization 1D
(new), Costpoint displays an error message.

= |f at least one of the users for the approval titles in the approval process is authorized for the organization ID
(new), Costpoint displays a warning message.

Approve Sales Orders (OEMAPPSO)
The following are the changes to this screen:

= Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s authorization
for the new organization ID. In addition, Costpoint will not display sales orders where organizations are left
blank.

= Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights.
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Approval Process (when approval process is enabled and you submit sales orders for approval) — If you add an
approval process/approval title, at least one of the users for each approval title(s) must be authorized for the
organization ID.

= If none of the users for any of the approval titles in the approval process is authorized for the organization ID
(new), Costpoint displays an error message.

= |f at least one of the users for the approval titles in the approval process is authorized for the organization ID
(new), Costpoint displays a warning message.

Print Sales Order Acknowledgments (OERACKN)
The following are the changes to this screen:

Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights.

Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display sales orders
where organizations are left blank.

When you click Print/Preview, Costpoint displays all records where you have full rights to the organization.

When you select Flag SO Acknowledgment as Printed, Costpoint only updates record flags where you have
full rights to the organization.

Logic has been added to the application to suppress all line details in the report if your logged-in user ID does
not have full rights to the sales order organization, and the following message is printed: “Sales
Acknowledgment not printed. Your user ID is not authorized for the Organization on this Sales Order.”

Manage Sales Order User-Defined Information (OEMSOUDI)

Costpoint now finds and filters existing sales order records based on your logged-in user ID’s organization rights for the
new organization ID. In addition, Costpoint will not display sales orders where organizations are left blank.

Create Purchase Requisitions from Sales Orders (OEPGRQ)
The following are the changes to this screen:

Costpoint now validates your selected/entered entries against your logged-in user ID's organization and
requisitioner’s organization rights.

Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where
organizations are left blank.

When you click Execute, Costpoint will only display and process records where you have full rights to the
organization.

Approval Process — If organization security is enabled in the system settings, and the screen is activated for
organization security, Costpoint will not allow you to enter or select an SO if your user ID is not authorized for
the requisitioner’s organization linked to the SO.

= If none of the users for any of the approval titles in the approval process is authorized for the requisitioner’s
organization, Costpoint generates the requisition but the approval process code is left blank, and status is
set to Pending.

= |f at least one of the users for the approval titles in the approval process is authorized for the requisition
organization, Costpoint generates requisitions with Approval and In-Approval status.

When your logged-in user ID is not authorized for the organization linked to the SO which you created a
requisition for, Costpoint prints a report with the following error message: “Requisition not created. Your user ID
is not authorized for the Organization linked to this Sales Order.”

Print Sales Order Pick List (OERPICK)
The following are the changes to this screen:
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= Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display sales orders
where organizations are left blank.

= When you click Print/Preview, Costpoint displays all records where you have full rights to the organization.

= When you select the Update Sales Order Pick List printed flag, Costpoint only updates and processes records
where you have full rights to the organization.

= When you click an SO and the SO selected is linked to an organization not authorized for your logged-in user
ID, Costpoint displays an error message.

= Logic has been added to the application to suppress all line details in the report if your logged-in user ID does
not have full rights to the organization linked to the SO, and the following message is printed: “SO information
not printed. Your user ID is not authorized for the Organization on this Sales Order.”

Manage Sales Order Inventory Issues (OEMISSUL)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entries against your logged-in user ID's organization and project
owning organization rights.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where
organizations are left blank.

= Anew field, Organization, has been added to the screen to display the organization ID for the sales order.
= Costpoint now saves the organization linked to the sales order in the inventory transaction table.

Manage Sales Order Non-Inventory Issues (OEMISSU2)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entries against your logged-in user ID's organization rights.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where
organizations are left blank.

= Anew field, Organization, has been added to the screen to display the organization ID for the sales order.
= Costpoint now saves the organization linked to the sales order in the inventory transaction table.

Manage Shipping Transactions (OEMSHIP)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entries against your logged-in user ID's organization rights.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where
organizations are left blank.

= Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s authorization
for the organization linked to the SO associated with the shipping transactions. If this organization ID in the
header section is blank, Costpoint will not display the record.

= Anew field, Organization, has been added to the screen to display the organization ID for the sales order.

Print Packing Slips (OERPCKSL)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entries against your logged-in user ID's organization rights.
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Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where
organizations are left blank.

When you click Print/Preview, Costpoint displays all records where you have full rights to the sales order’s
organization.

When you select Flag Packing Slip as Printed, Costpoint only updates and processes records where you have
full rights to the sales order’s organization.

Logic has been added to the application to suppress all line details in the report if your logged-in user ID does
not have full rights to the organization linked to the SO, and the following message is printed: “SO information
not printed. Your user ID is not authorized for the Organization linked to this sales order.”

Print DD250 Packing Slips (OER250PS)
The following are the changes to this screen:

Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display sales orders
where organizations are left blank.

Costpoint now validates your selected/entered entries against your logged-in user ID's organization rights.

When you click Print/Preview, Costpoint displays packing slips where you have full rights to the sales orders’
organization.

When you select Flag DD250/WA250 Packing Slips as Printed, Costpoint only updates the flag of the packing
slips where you have full rights to the sales orders’ organization.

Logic has been added to the application to suppress all line details in the report if your logged-in user ID does
not have full rights to the organization associated with the SO in the packing slip, and the following message is
printed: “Packing Sip information not printed. User is not authorized for the organization linked to the sales
order.”

Print WA250 Packing Slips (OERW250P)
The following are the changes to this screen:

Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked to
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display sales orders
where organizations are left blank.

Costpoint now validates your selected/entered entries against your logged-in user ID's organization and sales
order’s organization rights.

When you click Print/Preview, Costpoint displays packing slips where you have full rights to the sales orders’
organization.

When you select Update DD250/WA250 Printed Flag, Costpoint only updates the flag of the packing slips
where you have full rights to the sales orders’ organization.

Logic has been added to the application to suppress all line details in the report if your logged-in user ID does
not have full rights to the organization associated with the SO in the packing slip, and the following message is
printed: “Packing Slip information not printed. User is not authorized for the organization linked to the sales
order.”

Print Sales Order Approval Status Report (OERAPPR)
The following are the changes to this screen:

Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights for the
SO.
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= Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with organizations that are
authorized for the logged-in user ID.

= When you click Print/Preview, Costpoint displays records where you have full rights to the SO organization. In
addition, Costpoint will not display sales orders where organizations are left blank.

Print Sales Order Backlog Report (OERBLOG)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights for the
SO.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with organizations that are
authorized for the logged-in user ID.

= When you click Print/Preview, Costpoint displays records where you have full rights to the SO organization. In
addition, Costpoint will not display sales orders where organizations are left blank.

View Sales Analysis Information (OEQSALES)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights for the
SO.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with organizations that are
authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where organizations are
left blank.

= When you click Execute, Costpoint displays records where you have full rights to the SO organization. In
addition, Costpoint will not display sales orders where organizations are left blank.

Create RFID Print File (OEPRFID)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights for the
SO.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with organizations that are
authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where organizations are
left blank.

= When you select Create RFID Print File, Costpoint displays records where you have full rights to the SO
organization. In addition, Costpoint will not display sales orders where organizations are left blank.

View Sales Order Status Information (OEQSTAT)
The following are the changes to this screen:

= Costpoint now validates your selected/entered entry against your logged-in user ID's organization rights for the
SO.

= Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with organizations that are
authorized for the logged-in user ID. In addition, Costpoint will not display sales orders where organizations are
left blank.

=  When you click Execute, Costpoint displays records where you have full rights to the SO organization. In
addition, Costpoint will not display sales orders where organizations are left blank.

Import Sales Orders (AOPSOPP)

The logic of this application has been changed to load/populate the new Organization field on the Manage Sales Orders
screen.
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Load Organization IDs (OEPLDORG)

Use this new screen (Materials » Sales Order Entry » Sales Order Entry Utilities » Load Organization IDs) to load
or default a value to the new field, Organization, for sales orders.

Note: You must run this utility before turning on organization security for a module. If you skip this
process, query results will exclude sales orders with blank organization IDs.

Load Organization IDs (INPLDORG)

Use this new screen (Materials » Inventory » Inventory Utilities » Load Organization IDs) to load or default material
handler's organizations for miscellaneous receipts and location transfer IDs. This utility automatically runs in the
backend to populate the inventory transaction table for the other inventory transaction types such as Issue to Purchase
Order (ISSUEPO), Issue to Manufacturing Order (ISSUEMO), Quantity Adjustment (ADJQTY), Cost Adjustment
(ADJCST), Scrap Adjustment (ADJSCRAP), Project/Account Transfer (TRNFPAO), PO Receipt (TRNFRCPT). It
populates either the owning organization linked to the project or the material organization linked to the inventory
abbreviation associated with the inventory transaction.

Note: You must run this utility before turning on organization security for a module. If you skip this
process, query results will exclude sales orders with blank organization IDs.

Create Inventory Allocations (INPALLOC)
The following are the changes to the lookup screen:
= Manufacturing Order — Costpoint now narrows the search and displays only manufacturing orders (MOs) where

the logged-in user ID is authorized for the planner’s organization ID. Costpoint will not display MOs without the
planner’s organization ID.

= Purchase Order — Costpoint now narrows the search and displays only POs where the logged-in user ID is
authorized for the buyer’s organization ID. Costpoint will not display POs without the buyer’s organization ID.

= Inventory Issues — Costpoint now narrows the search and displays only inventory issue records where the
logged-in user ID is authorized for the To Organization. Costpoint will not display records with blank To
Organization.

= Inventory Transfer — Costpoint now narrows the search and displays only records where the logged-in user ID
is authorized for the To Organization. Costpoint will not display records with blank To Organization.

= Sales Order — Costpoint now narrows the search and displays only sales orders where the logged-in user ID is
authorized for the sales order organization ID. Costpoint will not display records sales order organization IDs are
left blank.

= Costpoint will not create allocations to the transactions where the logged-in user is not authorized for, or where
the reference organization IDs are left blank.

View Purchase Order Status (POQSTAT)
The following are the changes to this screen:
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Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s authorization
for the buyer’s organization ID. In addition, Costpoint will not display records where buyer’s organization IDs are
left blank.

Costpoint now validates your selected/entered entry against your logged-in user ID's rights to buyer’s
organization and organization linked to the requisition.

Lookup (Purchase Order) — Costpoint now narrows the search and displays only purchase orders (PO) with
buyer’s organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display POs
where buyer’s organizations are left blank.

Rename Process Flag
The Flag DD250 Packing Slips as Printed was renamed to Flag DD250/WA250 Packing Slips as Printed.

Configure Inventory Accounts (INMACCT)

Costpoint now narrows the search and displays only organizations authorized for your logged-in user ID. If you enter an
organization that you do not have full rights to, Costpoint displays the following error message: Your user ID does not
have access to the Organization: [Org ID].

Configure Default Project Inventory Accounts (INMWACCT)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the project’s owning organization.

Lookup

= Inventory Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID.

= Project Abbrev — Costpoint now harrows the search and displays only projects with owning organizations
authorized for the logged-in user ID.

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID.

Data Entry — If organization security is enabled in the system settings, and the screen is activated for
organization security, Costpoint will not allow you to enter or select records that your user ID does not have full
rights to. Costpoint displays error messages for unauthorized entries.

Manage Inventory Projects (INMPROJ)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the project’s owning organization.

Lookup

= Inventory Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID.

= Project Abbrev — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID.

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID.

A new field, Organization, has been added to the screen to display the owning organization of the inventory
project.
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Data Entry — If organization security is enabled in the system settings, and the screen is activated for
organization security, Costpoint will not allow you to enter or select records that your user ID does not have full
rights to. Costpoint displays error messages for unauthorized entries.

Enter Scrap Adjustments (INMSCADJ)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights to the adjusting organization on the transaction. When your rights to the adjusting organization have been
established, Costpoint displays all other information, regardless of your rights to associated projects and
inventory abbreviations.

Lookup

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID. In addition, Costpoint displays only organizations that the material handler and approver
are authorized for when you do a lookup of material handler/approver project and organization.

= Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the material handler
and approver are authorized for when you do a lookup of material handler/approver project and
organization.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations that the material handler and approver are authorized for when you do a lookup of
material handler/approver project and organization.

New records — When you enter scrap inventory abbreviation, Costpoint defaults to the material account,
material organization, and organization abbreviation in the scrap at the header level. In addition, Costpoint now
saves the scrap organizations in the inventory transaction organization ID table.

Enter Inventory Transfers (INMPAXFR)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the Inventory Abbrev in the To group box of the transaction header. When your rights to the scrap
inventory abbreviation’s organization have been established, Costpoint displays all transaction lines, regardless
of your rights to associated projects and inventory abbreviations.

Lookup

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations with projects and organizations that the material handler is authorized for when you
do a lookup of material handler/approver project and organization.

= Reservation — Costpoint now narrows the search and displays only reservations with organizations from
the To group box authorized for the logged-in user ID..

A new field, Organization, has been added to the screen to display the default value from the inventory
abbreviation code.

New records — When you enter the Inv Abbrev in the To group box, Costpoint defaults to the material
organization at the header level. In addition, Costpoint now saves organizations of the To group box in the
inventory transaction table.

Manage PO/Req Inventory Reservations (INMPORSV)
The following are the changes to this screen:
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Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights to the buyer’s organization associated with the PO or the requisitioner’s organization associated with the
requisition on the reservation header. When your rights have been established, Costpoint displays all
reservation lines, regardless of your rights to associated projects and inventory abbreviations.

Lookup

= PO/RIse — Costpoint now narrows the search and displays only PO/RIse records authorized for the logged-
in user ID.

= Requisition — Costpoint now narrows the search and displays only requisition records authorized for the
logged-in user ID.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects (owning organization) authorized for the logged-in user ID. In addition, Costpoint
displays only inventory abbreviations with projects and organizations that the requester is authorized for
when you do a lookup of the requester.

A new field, Organization, has been added to the screen to display the default value from the purchase order
(PO) line or requisition line.

A new field, Org Abbrev, has been added to the screen to display the default value from the inventory
abbreviation code.

Data Entry — If organization security is enabled in the system settings, and the screen is activated for
organization security, Costpoint will not allow you to enter or select POs or requisitions associated with the
organizations that your user ID does not have full rights to. Costpoint displays error messages for unauthorized
entries.

Create Inventory Allocations (INPALLOC)
The following are the changes to the lookup screen:

Manufacturing Order — Costpoint now narrows the search and displays only manufacturing orders (MOs) where
the logged-in user ID is authorized for the planner’s organization ID. Costpoint will not display MOs without the
planner’s organization ID.

Purchase Order — Costpoint now narrows the search and displays only POs where the logged-in user ID is
authorized for the buyer’s organization ID. Costpoint will not display POs without the buyer’s organization ID.

Inventory Issues — Costpoint now narrows the search and displays only inventory issue records where the
logged-in user ID is authorized for the To Organization. Costpoint will not display records with blank To
Organization.

Inventory Transfer — Costpoint now narrows the search and displays only records where the logged-in user ID
is authorized for the To Organization. Costpoint will not display records with blank To Organization.

Sales Order — Costpoint now narrows the search and displays only sales orders where the logged-in user ID is
authorized for the sales order organization ID. Costpoint will not display records with blank sales order
organization ID.

Costpoint will not create allocations to the transactions where the logged-in user is not authorized for, or where
the reference organization IDs are left blank.

Enter Issues to Project/Account/Org or PO (INMPAISS)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the To Organization, or the PO/RIse buyer organization in the To group box of the transaction header.
When your rights to the header organization ID have been established, Costpoint displays all transaction lines,
regardless of your rights to associated projects and organization rights associated with the From Inv Abbrev at
the line level.
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Lookup

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID. In addition, Costpoint displays only organizations that the material handler is authorized
for when you do a lookup of material handler project and organization.

= Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the material handler is
authorized for when you do a lookup of material handler project and organization.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations that the material handler is authorized for when you do a lookup of material handler
project and organization.

New records (Issue Type=Issue to Project/Account) — When you enter To Expense Inv Abbrev, Costpoint
defaults to the material organization and organization abbreviation at the header level. In addition, Costpoint
now saves organizations of the To group box in the inventory transaction table.

New records (Issue Type=Issue to Purchase Order) — When you enter PO/RIse and line, Costpoint defaults to
the PO line inventory abbreviation in the To Expense Inv Abbrev and its associated projects in the To Project.
In addition, Costpoint now saves organizations of the To group box in the inventory transaction table.

Enter Cost Adjustments (INMCSADJ)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the part to adjust the inventory abbreviation’s organization. When your rights to the header
organization ID have been established, Costpoint displays all transaction lines, regardless of your rights to
associated projects and organization rights associated with the part to adjust the inventory abbreviation’s
organization.

Lookup

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID. In addition, Costpoint displays only organizations that the adjuster and approver is
authorized for when you do a lookup of adjuster/approver project and organization.

=  Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the adjuster and
approver is authorized for when you do a lookup of adjuster/approver project and organization.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviation that the adjuster and approver is authorized for when you do a lookup of
adjuster/approver project and organization.

A new field, Organization, has been added to the screen. Use this field to enter the organization to be charged
for this adjustment.

A new field, Org Abbrev, has been added to the screen. Use this field to enter the organization abbreviation 1D
to be charged for this adjustment.

New records — When you enter a part to adjust inventory abbreviation, Costpoint defaults to the material
organization and organization abbreviation at the header level. In addition, Costpoint now saves organizations of
the To group box in the inventory transaction table.

Enter Quantity Adjustments (INMQTADJ)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the adjusting inventory abbreviation’s organization. When your rights to the adjusting inventory
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abbreviation’s organization have been established, Costpoint displays all transaction lines, regardless of your
rights to associated projects and organizations.

Lookup

= Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID. In addition, Costpoint displays only organizations that the material handler and approver
are authorized for when you do a lookup of an organization.

= Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the material handler
and approver are authorized for when you do a lookup of a project.

= Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations that the material handler and approver are authorized for when you do a lookup of
an inventory abbreviation.

New records — When you enter an adjusting inventory abbreviation, Costpoint defaults to the material
organization and organization abbreviation at the header level. In addition, Costpoint now saves the adjusting
organization ID in the inventory transaction table.

Enter Location Transfers (INMLOXFR)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the material handler’s organization. When your rights to the material handler’s organization have been
established, Costpoint displays all transaction lines, regardless of your rights to associated projects and
organizations.

Lookup — Costpoint now narrows the search and displays only inventory abbreviations with projects and
organizations authorized for the logged-in user ID. In addition, Costpoint displays only projects and
organizations that the material handler is authorized for when you do a lookup of an inventory abbreviation.

New records — When you enter a material handler, Costpoint defaults to the material organization at the header
level on the Employee Salary Information (LDMEHIS) screen. In addition, Costpoint now saves the material
hander’s organization in the inventory transaction table.

Create Mass Inventory Transfers (INPMSXFR)
The following are the changes to this screen:

Lookup — Costpoint now narrows the search and displays only inventory abbreviations with project owning
organizations and organizations authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations with projects and organizations that the material handler is authorized for when you do a
lookup of an inventory abbreviation.

Costpoint now saves the material organization linked to the To Inv Abbrev in the inventory transaction table.

Manage Inventory Requests (INMRQST)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights for the To Inv Abbrev organization or To Organization on the request header. When your rights to the
To Inv Abbrev organization or To Organization have been established, Costpoint displays all transaction lines,
regardless of your rights to associated projects and organizations associated with the From Inv Abbrev at the
line level.

Lookup
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Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID. In addition, Costpoint displays only organizations that the requester is authorized for
when you do a lookup of an organization.

Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the requester is
authorized for when you do a lookup of a project.

Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations with projects and organizations that the requester is authorized for when you do a
lookup of an inventory abbreviation.

New records — When you enter To Inv Abbrev, Costpoint defaults to the material account, material
organization, and organization abbreviation at the header level.

Manage Inventory Reservations (INMPARSV)
The following are the changes to this screen:

Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights to the To Organization on the reservation header. When your rights to the or To Organization have
been established, Costpoint displays all transaction lines, regardless of your rights to associated projects and
organizations associated with the From Inv Abbrev at the line level.

Lookup

Organization — Costpoint now narrows the search and displays only organizations authorized for the
logged-in user ID. In addition, Costpoint displays only organizations that the requester is authorized for
when you do a lookup of an organization.

Project — Costpoint now narrows the search and displays only projects with owning organizations
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the requester is
authorized for when you do a lookup of a project.

Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only
inventory abbreviations with projects and organizations that the requester if authorized for when you do a
lookup of an inventory abbreviation.

New records — When you enter To Inv Abbrev, Costpoint defaults to the material account, material
organization, and organization abbreviation at the header level.

Print Purchase Price Variance Analysis Report (INRPPV)

When you select Print Options - Standard Costing, Costpoint will not print the purchase order (PO) price variance details
by project/PO if logged-in user ID is not authorized for the PO buyer organization, and Costpoint will instead display the
following message: PO Variance not printed - Your user ID is not authorized for the PO Buyer Org.

Create Purchase Price Variance Journal Entry (INPPPV)

When you select Print/Preview/Create, Costpoint processes all records but detailed report will only be displayed for
purchase orders (PO) with buyer organization that the logged-in user ID is authorized for.

Print Inventory Reorder Report (INPREORD)
The following are the changes to this screen:

Lookup — Costpoint now narrows the search and displays only projects with owning organizations authorized
for the logged-in user ID.

Report — Costpoint now validates header project against the logged-in user ID if One or Range is selected as
an option, and reports are printed by project.
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Print Inventory Transaction History (INRHSTPA)

If organization security is enabled in the system settings, and the screen is activated for organization security, Costpoint
will not allow you to select records that your user ID does not have full rights to. Costpoint displays an error message for
unauthorized entries.

The transaction type indicated in the inventory transaction and your logged-in user ID authorization determine the
records that Costpoint allows you access to.

Costpoint will allow you access to records from the inventory transaction table with the following transaction types and
logged-in user ID authorization combination:

Transaction Type User ID Authorized for

Issue to Project/Account To Organization

Issue to Purchase Order To Organization

Quantity Adjustment Adjusting Org

Scrap Adjustment Adjusting Org

Cost Adjustment Part to Adjust Inv Abbrev’s Org
Project/Account Transfer Organization

Location Transfer Material Handler's Org
Miscellaneous Receipt Material Handler’'s Org

Load Organization IDs (INPLDORG)

Use this new screen (Materials » Inventory » Inventory Utilities » Load Organization IDs) to load or default material
handler’s organizations for miscellaneous receipts and location transfer IDs. This utility automatically runs in the
backend to populate the inventory transaction table for the other inventory transaction types such as Issue to Purchase
Order (ISSUEPO), Issue to Manufacturing Order (ISSUEMO), Quantity Adjustment (ADJQTY), Cost Adjustment
(ADJCST), Scrap Adjustment (ADJSCRAP), Project/Account Transfer (TRNFPAQO), PO Receipt (TRNFRCPT). It
populates either the owning organization linked to the project or the material organization linked to the inventory
abbreviation associated with the inventory transaction.

View Inventory Transaction History (INQHSTPR)

Costpoint now narrows the search and displays only inventory transactions with organizations authorized for the logged-
in user ID.

View Part Inventory (INQPINV)

Costpoint now narrows the search and displays only projects for which you want to do an inventory with organizations
authorized for the logged-in user ID. In addition, Costpoint now narrows the search and displays only projects with
owning organizations authorized for the logged-in user ID.

Import Inventory Transactions (AOPINTRN)

Costpoint now loads/populates values in the inventory transaction table.

Enter Miscellaneous Inventory Receipts (RCMMSRC)
The following are the changes to this screen:

= Anew field, Organization, has been added to the screen. Use this field to enter the material handler
employee’s organization ID.
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= Data Entry — If organization security is enabled in the system settings, and the screen is activated for
organization security, Costpoint will not allow you to enter or select records that your user ID does not have full
rights to. Costpoint displays error messages for unauthorized entries.

= Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization
rights.

INMRQSTLIB Library

The INMRQSTLIB library contains common business logic, which is shared by the following applications:
= Manage Inventory Reservations (INMPARSV)
= Manage Inventory Requests (INMRQST)

INMADJLIB Library

The INMADJLIB library contains common business logic, which is shared by the following applications:
= Enter Quantity Adjustments (INMQTADJ)
= Enter Scrap Adjustments (INMSCADJ)

MMDLVRYSCHDLIB Library

The MMDLVRYSCHDLIB library contains common business logic, which is shared by the following applications:
= Manage Purchase Requisitions (PPMNTRQ1)
= Manage Purchase Orders (POMMAIN)
= Approve Pending Purchase Orders (POMSTAT)
=  Apply PO Info to Purchase Requisitions (PPMNTRQ2)
= Create Blanket Purchase Order Releases (POMRELS)
= Expedite Purchase Orders (POMEXPD)
=  Apply PO Info to Purchase Requisitions by Line (PPMRQLN)
= View Purchase Order Status (POQSTAT)
= View ltem Purchasing Information (POQITEM)
= View Purchase Order Change Orders (POQCHNG)
= Approve Purchase Requisitions (PPMRQAPX)
= Manage Purchase Order Vouchers (POMPOVCH)
= Approve Purchase Requisition Lines (PPMRQAPL)
= Assign Purchase Requisition to Buyers (PPMBUYAS)
= Assign Purchase Requisition Lines to Buyers (PPMBUYAL)
= View Purchase Requisition Status (PPQRQSTS)
=  View Part Inventory (INQPINV)
= Manage Detailed Part Schedule (MRMDTPT)
= View Summary Part Availability (MRQSPA)
= Manage Simple Purchase Requisitions (PPMQREQ)

DVGMESUBLIB Library
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The DVGMESUBLIB library contains common business logic, which is shared by the following applications:
= Manage Proposal BOM Cost Estimates-Indented (MEMPRPLI)
= Manage Proposal BOM Cost Estimates-Summarized (MEMPRPLS)

OEQSTATLIB Library

The OEQSTATLIB library contains common business logic, which is shared by the following applications:
= Select Invoices Ready for Use/Acceptance (OEMRFU)
= View Sales Analysis Information (OEQSALES)
= View Sales Order Status Information (OEQSTAT)

PCMMOISSLIB Library

The PCMMOISSLIB library contains common business logic, which is shared by the following applications:
= Enter Manufacturing Order Issues (PCMMOISS)
= Enter Manufacturing Order Issues (INMMOISS)

DVGMSSUBLIB Library

The DVGMSSUBLIB library contains common business logic, which is shared by the following applications:
= Manage MRP Action Messages (MRMACTM)
= Manage Mater Production Schedule Action Messages (MSMACTM)
= Manage Detailed Part Schedule (MRMDTPT)

Organizational Security

The Organizational Security feature enhances the secure functionality of Costpoint by warranting proper user access
throughout the Materials domain. This feature ensures that correct user access is applied to the logged-in user ID in
accessing records by validating and filtering records/transactions as authorized for the user ID.

Manage Vendor Returns (RCMRTRN)

Costpoint now finds and filters existing records based on your logged-in user ID’s organization rights for the original PO
buyer’s organization ID. This change allows you to see POs with the original PO buyer’s organization ID that you are
authorized for. Costpoint will not display POs without the buyer’s organization ID.

Other Screen Updates for Organizational Security
Changes were made on these screens in preparation for the future implementation of the Organization Security feature:
= Enter Issues to Project/Account/Org or PO (INMPAISS)
= Enter Quantity Adjustments (INMQTADJ)
= Enter Scrap Adjustments (INMSCADJ)
=  Enter Location Transfers (INMLOXFR)
= Create Mass Inventory Transfers (INPMSXFR)
= Manage Inventory Requests (INMRQST)
= Manage Inventory Reservations (INMPARSV)
= Print Inventory Reorder Report (INPREORD)
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Print Inventory Transaction History (INRHSTPA)
View Inventory Transaction History (INQHSTPR)
Configure Inventory Accounts (INMACCT)

Configure Default Project Inventory Accounts (INMWACCT)

Manage Inventory Projects (INMPROJ)

Enter Cost Adjustments (INMCSADJ)

Enter Inventory Transfers (INMPAXFR)

Manage PO/Req inventory Reservations (INMPORSV)
Create Inventory Allocations (INPALLOC)

MRQSPALIB Library

The MRQSPALIB library contains common business logic, which is shared by the following applications:

View Summary Part Availability (MRQSPA)
Manage Detailed Part Schedule (MRMDTPT)

POMPOLIB Library

The POMPOLIB library contains common business logic, which is shared by the following applications:

Expedite Purchase Orders (POMEXPD)

Manage Purchase Orders (POMMAIN)

Create Blanket Purchase Order Releases (POMRELS)
Update Subcontract Retainage PO Status (POMSCST)
Approve Pending Purchase Orders (POMSTAT)

View Purchase Order Change Orders (POQCHNG)
View Item Purchasing Information (POQITEM)

View Purchase Order Status (POQSTAT)

View Purchase Requisition Status (PPQRQSTS)
Manage Purchase Order Vouchers (POMPOVCH)
Create Debit Memos (POPDM)

Approve Subcontractor Invoices (SMMAINVC)
Manage Subcontractor Invoices (SMMMINVC)

BMMMDOCLIB Library

The BMMMDOCLIB library contains common business logic, which is shared by the following applications:

Manage Documents (BMMMDOC)
Release Documents (BMMRDOC)

MMQALLOCLIB Library

The MMQALLOCLIB library contains common business logic, which is shared by the following applications:

View Part Inventory (INQPINV)
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= View Manufacturing Order Status (PCQMOST)
Administration
New Word Template Application and Add-In

The Costpoint Word Template Add-in is available to download from Deltek Software Manager. Use the add-in to
easily build Word report templates which are then used with the new Manage Word Templates (SYMWRPTM)
application in Costpoint to print customized reports.

Improved User Configuration Screen

The User Configuration screen has been renamed as User Preferences and the fields were reordered to streamline
navigation to support the upcoming release of Costpoint’'s new Ul.

Reordered Fields

The following image displays the User Preferences screen with reordered fields. In this example, the Manage Journal
Entries screen was open when the User Preferences screen was launched.

[ ]
La

| CPSUPERUSER T

Company Mame: Company 1 =
System: CTAIMQCO11
Walidation
Frequency: Field

Application Preferences

Manage Journal Entries
Application Layout Changes Save

Global Toolbar leon Options Edit =

Auto Positioning On «

diClose all applications to turn Auto Fositioning on/off.

Manage User Profiles

Lk Close all applications to access User Profiles.

View Applications || Close Applications || Cancel

Manage "My Menus” in "Cenfigure User Prefersnces”

Note: The Manage User Profiles section only appears for System Administrators.

Updated Copyright on Welcome Screen

The copyright information is updated to reflect the year of the most recent Costpoint release.

Improved Costpoint Mobile Menu

The menu items in the mobile menu are renamed to support the upcoming release of Costpoint’s new Ul and reordered
to streamline navigation.

Changes to the Mobile Menu

Reordered and Renamed Menu Items
The update to menu items are explained in the following table:
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Favorites My Menu (star icon)
Apps Browse Applications
Search apps Application Search
Running apps Open Application
File Menu Global Menus

User (Screen) Config ~ User Preferences

Company Select Company
Help Help
Logout Log Out

Also, if multiple icons fill the toolbar, then the My Menu icon will display in the mobile menu instead of the toolbar.
* = W Y R —

Browse Applications My Menu

*
i B Applicat
Application Search E] rowse Applications
%

o Application Search
Open Applications

Open Applications

EF Global Menus
i

Global Menus

User Preferences
User Preferences

Select Company

c o= e ] o

& Select Company
Help ? Help
Log out th Log out
My Menu icon on the toolbar My Menu in the Mobile menu

Reports & Analytics
Role-Based Dashboards: Limitation on the Number of Dashparts Displayed

The number of dashparts that display on the Dashboard Reports tab depends on the number of dashparts you have
open on the Parameters tab and your screen resolution. For example, if your screen resolution is lower than 1680 pixels,
not all eight dashparts opened on the Parameters tab will be displayed on the Reports tab.

As a workaround, you can do any of the following:

= Toggle between the Parameters and Reports tabs to add (open) and remove (close) dashparts that you want to
view.
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= Drag the dashpart table windows up or down on the Parameters tab to rearrange the dashparts. Costpoint
displays the dashparts on the Reports tab in the order that they appear on the Parameters tab, first to last.

=  Set your screen resolution to 1920 pixels, which is the recommended resolution to view all dashparts. Note,
however, that if your screen does not support 1920 pixels, you will not be able to set that resolution.

Costpoint Integration

Deltek Talent Management Integration Enhancements

This Costpoint release provides the following enhancements to Costpoint - Deltek Talent Management integration:
= Automatically assign employee IDs and accept partial employee records
= Onboarding of rehired employees

= Populate the Last Day Worked field based on the termination date

Automatically Assign Employee ID and Import Partial Employee Records

This release provides the ability to auto-generate employee IDs in Costpoint. If you use Deltek Talent Management, you
can now import employee records that do not have employee ID values and allow Costpoint to auto-generate the IDs.
The auto-generate employee ID function is available to all Costpoint users when manually entering an employee record.
Only Deltek Talent Management users may import employees without employee IDs and have them auto generated.

Warning: If you use Deltek Talent Management; after you download this feature from DSM, you must perform the
applicable procedure in the Initialize Talent Management HUA ID-to-Costpoint Employee ID Mapping section.
Otherwise, the integration process between Costpoint and Deltek Talent Management will no longer function.

Configure Labor Settings (LDMLABOR)

= The Employee Options tab contains a new Auto-Generate Employee IDs check box enables the functionality
to automatically generate IDs for new employees. This check box displays as selected and disabled if you select
the Auto-Generate Employee IDs for All Companies check box on the Corporate Labor Settings subtask.
This functionality is currently only available for Deltek Talent Management users.

= The Corporate Labor Settings subtask contains a new Auto-Generate Employee IDs for All Companies check
box. Select this check box to enable Costpoint to automatically generate new employee IDs for companies
within the corporation.

Import Employee Data (AOPUTLEL)

If you select the Auto-Generate Employee IDs check box on the Configure Labor Settings screen, the following error
message displays when you attempt to open the Import Employee Data screen: “When auto-generation of employee IDs
is enabled in your company’s Configure Labor Setting screen, you may not import any new employee IDs.”

Link Talent Management User IDs to Existing Employees (EMPTMUI)

When you run this new toolkit, it will populate the Costpoint Employee (EMPL) table with each applicable employee’s
Deltek Talent Management user ID (HUA ID). It will also set the Active HUA ID Mapping flag which indicates whether
the Costpoint Employee has an active or inactive mapping to the HUA ID.

Attention: The timing of this toolkit depends on whether you're an existing Costpoint 7.1.1 user, an existing Deltek
Talent Management user, an existing client for both Costpoint 7.1.1 and Deltek Talent Management, or a new user for
both products.

You must run this toolkit after installing the Auto-Assign Employee IDs feature and before importing or exporting
employees in the Transfer Talent Management Data screen. Running this toolkit will populate the Deltek Talent
Management HUA ID (HUA_ID) and Active HUA ID Mapping (HUA_ACTV_MAP_FL) columns in the Manage Employee
Information (EMPL) table.
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For detailed steps on using this toolkit, please refer to the Talent Management HUA ID-to-Costpoint Employee ID
Mapping Initialization Scenarios section.

Manage Employee ID Defaulting Rules (EMMIDDEFAULT)

Use the new Manage Employee Defaulting Rules screen to enter and manage defaulting rules for your employee ID
format codes.

Note: You can access the Manage Employee ID Defaulting Rules screen only if you select the Auto-Generate
Employee IDs check box on the Configure Labor Settings screen. Otherwise, an error will display when you attempt to
open the application.

You must establish employee ID defaulting rules in the following scenarios:

= If you selected the Auto-Generate Employee IDs check box on the Configure Labor Settings screen for
companies, you must establish employee ID defaulting rules for each of company that has this labor setup.

= If you selected the Auto-Generate Employee IDs for All Companies check box on the Corporate Labor
Settings subtask of the Configure Labor Settings screen, you must establish at least one defaulting rule for all
companies or you can establish defaulting rules for each company.

To launch the screen, go to the People » Employee » Employee Controls menu.

Manage Employee ID Formats (EMMIDFORMAT)

Use the new Manage Employee ID Formats screen you to establish the formatting of employee IDs. Costpoint will use
this format when you opt to auto-generate the employee IDs.

Note: You can access the Manage Employee ID Formats screen only if you select the Auto-Generate Employee IDs
check box on the Configure Labor Settings screen. Otherwise, an error will display when you attempt to open the
application.

To launch the screen, go to the People » Employee » Employee Controls menu.
Manage Employee Information (LDMEINFO)
The following are updates on the Manage Employee Information screen:

= Anew HUA ID field allows you to enter the Talent Management user ID for the employee. The application uses
this field to map Costpoint employee IDs to Deltek Talent Management user IDs when you import employee
data into Costpoint.

= A new Talent Management Active HUA ID Mapping check box indicates whether or not the specified HUA ID
is actively mapped to the Costpoint employee. If this check box displays as selected, the Transfer Talent
Management Data application uses the specified HUA ID to determine whether or not the employee is a rehire.

= The application performs a validation to check the staging database tables when an adding an employee.

Print Data Dictionary Report

The Print Data Dictionary Report application now provides information for the following new columns on the Employee
(EMPL) table:

= HUA_ACTV_MAP_FL — Flag that indicates if the employee's HUA ID is active.
= HUA ID — HUA ID sent from Talent Management.
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Set Up Company (SYPCOMP)

When you create a new company, the application populates the EMPL_ID_AUTOGEN_FL column in the
LAB_SETTINGS database based on the values of the company being copied.

Transfer Talent Management Data (EMPHRSDAT)

= When you run the Transfer Talent Management Data process, the application generates employee IDs for
imported Deltek Talent Management employee records without IDs.

= The application adds employee records to staging database tables if the Deltek Talent Management records are
missing any required fields. The application will not add records to staging database tables if the employee ID is
missing and auto-generation of employee IDs is not enabled.

= The application performs validations to ensure that the imported file from Deltek Talent Management contains all
fields required to generate an employee ID. The application will not add records to the staging database tables if
it could not generate an employee ID.

= The application removes the employee records from the staging database tables once a complete employee
record is sent from Deltek Talent Management.

= The application uses the following staging database tables:
= EMPL_STG
= EMPL_PHONE_STG
* EMPL_LAB_INFO_STG
*» DFLT REG_TS STG
*» EMPL_TAX_STG

View Employee Information (PRQEINFO)

The screen contains new a HUA ID field and a Talent Management Active HUA ID Mapping check box. These display
the information from the same fields on the Manage Employee Information screen.

Onboarding of Rehired Employees

This feature provides the ability to include rehires when importing employees that have completed the onboarding
process in Deltek Talent Management. Importing of an existing Costpoint employee ID that was rehired to a different
company is not supported at this time.

Manage Employee Information (LDMEINFO)

The application was updated to support the processing of rehired employee records that were imported from Deltek
Talent Management to Costpoint through the Transfer Talent Management Data process.

Transfer Talent Management Data (EMPHRSDAT)

The following are the updates to the Transfer Talent Management Data screen for the onboarding of rehires:

= The application process can now identify new hires and rehires. It also determines and identifies when a new
employee record needs to be generated or if an existing record will be updated.

= When exporting employees, the application will not include employee records that does not have an active
mapping to a HUA ID (Talent Management User ID). An employee record does not have an active mapping if
the HUA_ID_ACTV_AP_FL columnis N.

= When importing rehires, if the employee record in Costpoint indicates that the employee is still employed (either
the Termination Date field is blank or the Termination Date value is later than the rehire date), an error will be
logged, and the rehired employee will not be imported.

Populate the Last Day Worked Field Based on the Termination Date
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When you enter a value in the Termination Date field on the Manage Employee Information screen, the screen displays
a warning message which provides you the option to populate the Last Day Worked field with the date that you entered
in the Termination Date field. If you decline the option to auto-populate the Last Day Worked field, you must manually

enter a date in the Last Day Worked field before saving the record.

Existing termination records will not be affected by this update and the warning message will only display for future
termination records.

Initialize Talent Management HUA ID-to-Costpoint Employee ID Mapping

Before you use Costpoint’s Auto-Assign Employee ID feature, you must run the Link Talent Management User IDs to
Existing Employees (EMPTMUI) toolkit based on your current Costpoint/Deltek Talent Management setup.

You must run the Link Talent Management User IDs to Existing Employees toolkit after downloading the Auto-Assign
Employee IDs feature and before importing or exporting employees in the Transfer Talent Management Data screen.
Running this toolkit will populate the HUA ID and Active HUA ID Mapping columns in the Manage Employee Information
table (EMPL.HUA_ID and EMPL.HUA_ACTV_MAP_FL).

Scenarios
Refer to the following scenarios and perform the corresponding steps that apply to your company’s setup:

Scenario 1

You currently use both products, Costpoint 7.1.1 and Deltek Talent Management, and you installed Costpoint’s
Auto-Assign Employee ID feature which was released in June 2018.

1 Deltek Talent Management = Generate the export_user_id_file file in Deltek Talent Management’s
Administration » Global Settings » Integration Setup » Costpoint »
Costpoint Configuration Check screen. This file maps the Talent Management
user IDs (HUA IDs) to the Costpoint Employee IDs.

2 Costpoint Use the export_user_id_file file you just generated in Deltek Talent
Management to run the People » Employee » Employee Utilities » Link
Talent Management User IDs to Existing Employees toolkit. You must
complete this step before you will be able to import new users from Deltek
Talent Management.

3 Costpoint Determine if you want to allow Costpoint to auto generate employee IDs.

Warning: If you choose to auto-generate employee IDs, you will not be able to
use Costpoint’s Import Employee Data application to import employees using a
data file.

= If you would like Costpoint to auto-generate Employee IDs for new hires
that come from Deltek Talent Management, proceed to Step 4.

= If you do not want Costpoint to auto-generate Employee IDs for new
hires that come from Deltek Talent Management, you have completed
the required steps and are ready to start importing new hires from
Deltek Talent Management.

4 Costpoint Go to People » Labor » Labor Controls » Configure Labor Settings screen,
select the Auto-Generate Employee IDs check box, and then save the record.
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Scenario 2

Go to Administration » System Administration » System Administration
Utilities » Rebuild Global Settings screen, select the Labor option in the
Individual Settings group box, and then run the application process.

You currently use Deltek Talent Management and you purchased Costpoint version 7.1.1 after May 2018.

1 Costpoint
2 Costpoint
3 Deltek Talent Management
4 Deltek Talent Management
5 Costpoint
6 Costpoint

Go to People » Labor » Labor Controls » Configure Labor Settings screen,
and ensure that the Auto-Generate Employee IDs check box is not selected.

Note: If the Auto-Generate Employee IDs check box is selected, clear the check
box. After saving your changes, go to the Rebuild Global Settings screen, select
the Labor option in the Individual Settings group box, and then run the
application process.

Create employee records in Costpoint. You can create employee records by
performing either of the following methods:

= Entering employee records on People » Employee » Basic Employee
Information » Manage Employee Information screen

= Importing an employee file on People » Employee » Employee
Interfaces » Import Employee Data screen.

Manually assign the newly created Costpoint employee IDs to your existing
Talent Management users.

Generate the export_user_id_file file in Deltek Talent Management's
Administration » Global Settings » Integration Setup » Costpoint »
Costpoint Configuration Check screen. This file maps the Talent Management
user IDs (HUA IDs) to the Costpoint Employee IDs.

Use the export_user_id_file file you just generated in Deltek Talent
Management to run the People » Employee » Employee Utilities » Link
Talent Management User IDs to Existing Employees toolkit. You must
complete this step before you will be able to import new users from Deltek
Talent Management.

Determine if you want to allow Costpoint to auto generate employee IDs.

Warning: If you choose to auto-generate employee IDs, you will not be able to
use Costpoint’s Import Employee Data application to import employees using a
data file.

= If you would like Costpoint to auto-generate Employee IDs for new hires
that come from Deltek Talent Management, proceed to Step 4.

= If you do not want Costpoint to auto-generate Employee IDs for new
hires that come from Deltek Talent Management, you have completed
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7 Costpoint
8 Costpoint
Scenario 3

the required steps and are ready to start importing new hires from
Deltek Talent Management.

Go to People » Labor » Labor Controls » Configure Labor Settings screen,
select the Auto-Generate Employee IDs check box, and then save the record.

Go to Administration » System Administration » System Administration
Utilities » Rebuild Global Settings, select the Labor option in the Individual
Settings group box, and then run the application process.

You currently use Costpoint 7.1.1 and you purchased Deltek Talent Management after May 2018.

1

Costpoint

Go to People » Employee » Employee Interface » Transfer Talent
Management Data screen, and run a full export of the following:

= Employees

= Organizations

= Job Templates
= Detail Job Titles

= Labor Locations

Note: You may opt to exclude employees that were terminated before a specific
date.

Deltek Talent
Management

Generate the export_user_id_file file in Deltek Talent Management’s
Administration » Global Settings » Integration Setup » Costpoint »
Costpoint Configuration Check screen. This file maps the Talent Management
user IDs (HUA IDs) to the Costpoint Employee IDs.

Costpoint

Use the export_user_id_file file you just generated in Deltek Talent
Management to run the Link Talent Management User IDs to Existing
Employees toolkit. You must complete this step before you will be able to import
new users from Deltek Talent Management.

Costpoint

Determine if you want to allow Costpoint to auto generate employee IDs.

Warning: If you choose to auto-generate employee IDs, you will not be able to
use Costpoint’s Import Employee Data application to import employees using a
data file.

= If you would like Costpoint to auto-generate Employee IDs for new hires
that come from Deltek Talent Management, proceed to Step 5.

= If you do not want Costpoint to auto-generate Employee IDs for new
hires that come from Deltek Talent Management, you have completed
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Costpoint
the required steps and are ready to start importing new hires from Deltek
Talent Management.
5 Costpoint Go to People » Labor » Labor Controls » Configure Labor Settings screen,
select the Auto-Generate Employee IDs check box, and then save the record.
6 Costpoint Go to Administration » System Administration » System Administration
Utilities » Rebuild Global Settings screen, select the Labor option in the
Individual Settings group box, and then run the application process.
Scenario 4

You purchased both products, Costpoint 7.1.1 and Deltek Talent Management, after May 2018.

1 Costpoint

2 Costpoint

3 Deltek Talent
Management

4 Costpoint

5 Costpoint

Create employee records in Costpoint. You can create employee records by
performing either of the following methods:

Entering employee records on People » Employee » Basic Employee
Information » Manage Employee Information screen

Importing an employee file on People » Employee » Employee Interfaces »
Import Employee Data screen.

Go to People » Employee » Employee Interface » Transfer Talent
Management Data screen, and run a full export of the following:

= Employees

= Organizations

= Job Templates
= Detail Job Titles

= Labor Locations

Generate the export_user_id_file file in Deltek Talent Management’s
Administration » Global Settings » Integration Setup » Costpoint »
Costpoint Configuration Check screen. This file maps the Talent
Management user IDs (HUA IDs) to the Costpoint Employee IDs.

Use the export_user_id_file file you just generated in Deltek Talent
Management to run the Link Talent Management User IDs to Existing
Employees toolkit. You must complete this step before you will be able to
import new users from Deltek Talent Management.

Determine if you want to allow Costpoint to auto generate employee IDs.
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Warning: If you choose to auto-generate employee IDs, you will not be able to
use Costpoint’s Import Employee Data application to import employees using a
data file.

= If you would like Costpoint to auto-generate Employee IDs for new
hires that come from Deltek Talent Management, proceed to Step 6.

= If you do not want Costpoint to auto-generate Employee IDs for new
hires that come from Deltek Talent Management, you have completed
the required steps and are ready to start importing new hires from
Deltek Talent Management.

6 Costpoint Go to People » Labor » Labor Controls » Configure Labor Settings screen,
select the Auto-Generate Employee IDs check box, and then save the record.

7 Costpoint Go to Administration » System Administration » System Administration
Utilities » Rebuild Global Settings screen, select the Labor option in the
Individual Settings group box, and then run the application process.

Errors

All warnings and errors are written to a log file (EMPTMUI_yymmddhhTms.log). The log file will be saved in the location
that you specified in the File Location field of the Link Talent Management User IDs to Existing Employees toolkit. If a

location has not been specified, warnings and errors will be written to the database and you can retrieve it from the File
Download (SYMDLMGR) screen.

Known Issues
Employees not Terminated in Costpoint were Processed as a Rehire
Deltek Defect Tracking Number: 963051

Description: When the Talent Management Active HUA ID Mapping column contains a value of No and the
employee has not been terminated in Costpoint, the Transfer Talent Management Data screen still allows you to
successfully import a rehired employee record into Costpoint.

Regardless of the value of Talent Management Active HUA ID Mapping column, the processing of rehires should not
be successful if the Costpoint employee record has no termination date.

Customers Impacted: This defect affects Costpoint - Deltek Talent Management Integration users.
Workaround Before Fix: None.

Additional Notes: The application performs a validation only if the employee has both a termination date and an active
HUA ID mapping. The HUA ID mapping must be active if there is no termination date as of the Deltek Talent
Management hire date.
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Planning

Planning Domain Created

access certain applications. See “Security Changes Required for New Modules” below for related

‘ Warning: This enhancement includes changes to security that will affect the ability of users to
information.

A Planning domain was added to Costpoint so that all the Budgeting & Planning applications can be housed in the same
location. Previously, Budgeting & Planning applications were contained within three separate Costpoint domains
(Accounting, Projects, and Administration).

A Proposal Budgeting module was also added, which contains certain applications that were previously located within
Project Budgeting. Additionally, planning-specific applications were relocated to a new Resource Planning module.

®]C)

% [0 Browse Applications Type here to search applici

Organization Budgeting
+| : Accounting Proposal Budgeting
Project Budgeting
Resource Planning

Administration
/' Contracts

€ Planning

Projects

The new domain and restructured menu help accommodate the many users who only need access to the planning
capabilities of Budgeting & Planning. .

Proposal Budgeting Module
Proposal Budgeting is now a separate module.
This module contains the Actions/Processing and the Reports/Inquiries applications.
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L S 1 =TT NENUL I Ty pe here to search applications

Organization Budgeting Actions/Processing

| — Accounting Proposal Budgeting Reports/Inquiries
Project Budgeting
Resource Planning

Administration
/' Contracts

£ Planning

Projects

=]C

b 1 =TT WY LILE L ER 7/ pe here to search applications

Organization Budgeting

Actions/Processing Create Proposal or Non Backlog (NPI1, NPI3, NPI&)

*‘ : Accounting Proposal Budgeting Reports/inguiries Project Proposals (NP14)
Project Budgeting Project Non-Backlog Budgets (NPI7)
Resource Planning Create Budget From Proposal (NPI8)
Administration Change Structured Proposal Start (NP110)

/ Contracts

£ Planning

EICTELLIILENLLEN Type here fo search applications

Organization Budgeting Actions/Processing Proposal Summary (Rev/Cost) (NPT1)

: - Accounting Proposal Budgeting Reports/inquiries Non-Backlog Budget Revenue Summary (Rev/Cost) (NPT2)
Project Budgeting Multi-Proposal Consolidation (Rev/Cost) (NPT3)
Resource Planning Structured Proposal Summary (Rev/Cost) (NPT4)

] Administration
/ Contracts

£ Planning

New Resource Planning Module

A new module called Resource Planning was also created. This module contains the Budget By Resource
application.
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FILE LINE OFTIONS PROCESS HELP

GHVVELIENWILE LN T)/pe here fo search applications

Budget By Resource

Organization Budgeting Resource Planning

+| i ACCOUFI“HQ Proposal Budgeting
Project Budgeting

Resource Planning

Administration
/' Contracts

€ Planning

Projects

Administration Module Changes

Budgeting Administration module was changed to Administration and the File Management module was removed. File
Management is now part of the Costpoint Administration Domain.

@]C)

% [0 Browse Applications Type here to search applications

Organization Budgeting System Security

+‘ : Accounting Proposal Budgeting Administration Reports
Project Budgeting Administration Controls
Resource Planning Administration Utilities
Administration

/ Contracts

€ Planning

o Projects

Security Changes Required for New Modules

The CP administrator needs to assign the Proposal Budgeting and Resource Planning modules to the User Groups
affected otherwise they will have no access to the new modules until new security is added.

To set User Groups, complete the following steps:
1. Click Administration » Security » System Security » Manage User Groups.
2. Select Assign Users to Group subtask
3. Select Module Rights subtask
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1.i'll;G-Mllipl- S -v - Sty | ] -.L.
 -— | [ )  Active Dty ID N =
1 k4 Unar (xroop 10* Haina ® [RAMA 2 sunshlama) w
BAP_ORG_USERS Cngarazaten Level Lisers. for BRP &
BEP PROJECT USERS Project Level Users for BAP ’
BEF REDUCED_ORG Reduced Ovg Level Lisers for BAP
BNF_ADMIN BAP Admurwsirafcn
BNP ORG BAF Cepamzabans
BHP FROJ BAF Frosects -
Anakgn Uiea 12 Giaup Module Bighls  Aghlidation Rights Aithos Dicechory Gigdips UEPielle
User Groups > Assign Users o Group hopw iy | T — e | LS I i
r
1* U * Mama Company *
ARTEMSISILS ARFEMSIH45 1
Clhoms

|
=

= Module Rights — Use this subtask to assign Read-Only, Full, or Deny rights in one or more Costpoint
modules to a user group by company.

For a complete listing of the new menu structure, see DeltekBudgetingandPlanning700MenuMapping70to61.pdf

Project Security Configuration Options Expanded

A Project Security to be Based On option was added to the Project tab of the Configuration Settings (MAM10) screen.
Options include Org ID or Project Budget Security.

£l UOCENOEGE0

* Browse Applications = Admin = Budgeting Administration > Administration Controls = Configuration Settings (MAM10)
Configuration Settings (MAM10) O—x
Account _ Display _ General _lIntegration _ Organization
Project Budget Period Method * [Accounting Periods/Sub Periods ¥ [] Unlock EAC Last Closed Period
Project Account Group Code l ] Resource Budget Commit Flag Default
Auto Plug Calculation * |Cﬁ [ Import Budget/EACs from Excel Commit Flag Default
Timesheet Import History * 36 Months
Timesheet Schedule Code STFR
Labor Escalation Month * |Employee's Anniversary Date  w
Labor Escalation Value * 200.00%
Workforce Rule [Enforce w
Project Security to be based on* m
-Select-
Crg ID

Prior to this enhancement, project security was automatically based on Org ID, which is still the default setting.
This configuration setting was primarily added to support the new Maintain Project Budget Security application.

Switching this setting to Project Budget Security allows Project Managers to view and edit all assigned budgets. If
security is based on Org ID, and for example, a Project manager has a Home Org of an Overhead type, he or she could
not edit project budgets and associated resources that have a Direct type of Home Org, such as Engineering or
Construction.
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Project Budget Security Applied to Project Budgets/EACs

The Project Budgets/EACs screen was also updated to reflect changes related to the new Project Security to be
based on setting.

If Project Security to be based on is selected as Project Budget Security, users will now have restricted access to
the projects that display in Project Budgets/EACs application.

Maintain Project Budget Security Application

A new Maintain Project Budget Security application was added that will enable Project Budget Accountants to separate
Project Budget Creators and Project Budget Approvers similar to Org Budgeting.

To access this new application, go to Planning » Administration » Administration Controls » Maintain Project
Budget Security

Bl 8  @a DaE

& (M Browse Apprications Planning = AGminslraton = Adminsiration Conltols > Maintaln Project Budgel Securily

Praject Select | Cix

Project Budget Approvers Rew Query w

= Project Rellup 10 * Wser ID* User Name Source

Project Budget Creators. Hew Query v | —

E Project 10 * e 10 * User Name Source

For more information screen fields, see the Maintain Project Budget Security online help topic.

Configure Project Budget Security

To use the Maintain Project Budget Security application, you need to select Project Budget Security from the drop-
down menu of the Project Security to be based on field of the Project tab of Planning » Administration »
Administration Controls » Configuration Settings (MAM10).

Note that default setting is Org ID.

Switching this setting to Project Budget Security allows Project Managers to approve and create project budget. If
security is based on Org ID, and for example, a Project manager has a Home Org of an Overhead type, he or she could
not edit project budgets and associated resources that have a Direct type of Home Org, such as Engineering or
Construction.

Note that with the addition of the new Project Security to be based on configuration option, the Manage Additional
Project Budget Approvers (MAP8) screen was made obsolete and has been removed. During installation, existing
entries from Project Budget Approvers (MAP8) are migrated to Maintain Project Budget Security, where they are
denoted by “MAP8” in the Source field.

Known Issue

Online Help for the Maintain Project Budget Security screen is not yet available for locally installed help, but it is for
hosted help. The issue will be fixed for local help installations in the next release.

Vendor Employee Enhancements

The Vendor Employee feature was further updated to include new configuration options as well as the ability to import
budgets/EACs for Vendor Employees from Excel.

Configuration Setting Updates
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The Planning » Administration » Administration Controls » Configuration Settings (MAM10) screen was updated
as follows.

Workforce Rule Enforced for Vendor Employees

If Workforce Rule on the Project tab is set to Enforce, that setting will now also be applied to Vendor Employees. Prior to
this enhancement it only enforced Employee Workforce. Note that the following screen text was added next to this field:
“Includes Employees, Vendors and Vendor Employees.”

S~ DRENORER0AE
% [0 Browse Applications > Planning = Administration = Adminisiration Controls > Configuration Seitings (MAM10)
Configuration Sentings (MAM10)
Account  Display

General _Integration _ Organization
dget > 1 counting Periods/Sub Periods

Code |

On v

Employee’'s Anniversary Dale x

Enforce v Includes Emplayees Vendors and Vendor Emplayess

Project Security to be based on™ Project Budgel Secunity ¥

New Display Option

An Include Vendor Employees in Vendor Lookups and Drop-Down lists check box was added to the Display tab.
Select this check box to include Vendor Employees in drop-down lists for screen entry and reporting.

OREECRRAE

Administration *

(S -

& [0 drowse Apphcations = Administtation Controls > Configuration Settings (MAM10)

Configuration Sertings (MAM10)

roiect
01731108

JAN-08 .

3-JANDE v

Exclude From Pending Charges v

Exclude From Total Cost v

Note that there is an existing setting for Employee Vendors (Include Employees Vendors in Vendor Lookups and
Drop-Down ), which you should take care not to confuse with the new setting for Vendor Employees, who are
employees of a subcontractor Vendor.

Conversely, Employee vendors are regular employees who have been set up as Vendors in Accounting » Accounts
Payable » Vendors » Manage Vendors so that they can submit Expense Reports that are processed through Accounts
Payable.

Import Vendor Employee Budget/EACs from Excel

The Import Budget/EACs from Excel application was updated to include the ability to import budgets for Vendor
Employees.
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To access this new option, go to Planning » Project Budgeting » Controls and Utilities » Import Budget/EACs from
Excel, and click the Excel Template subtask. Follow screen instructions for downloading the updated template, which
now includes Vendor Employee as an option in the ID Type drop-down list.

=] s DeltekBudgetingAndPlanningProjectBudgetExcelTemplatexlsx - Excel TABLE TOOLS
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER TEAM DESIGN
L= ¥ Cut i v | = _ = - [=u]
Calibri Sl - A A T == # EWapTe Text - | /4 | Mormal Bad o=
past 2 Copy ~ c d ! Forme d I - IEEI
aste P B - === &= a= Merne & Centar - «0 o onditional Format as | Goo Meutra — nsert
- FomatPamer  © T U - bDrar === &% Merge & Center $-% 0 W Farmatting = Table - . -
Clipboard ] Font [F] Alignment [F] Number ] Styles
o . f
A B C D E F G H 1 J

Hourly Rate n

ric B

Period End Date D Type K i B pool org DB  Account 1D B

Project 1D B

Vendor Employee
Generic
Key Entr

[T, RSNV SR

Note: An Hourly Rate for Vendor Employees should be completed on the Excel Template.

Budget Labor Hours by GLC or PLC

Labor budgeting was enhanced to allow budgeting by labor category, either GLC (general labor category) or PLC
(project labor category), without the need to specify a resource.

This update was applied to the following applications within the Planning Domain:
= Project Budgeting » Budget/EAC Processing » Project Budget/EACs
= Proposal Budgeting » Actions/Processing » Project Proposals (NP14)
= Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7)

When budgeting labor in the Staff Hours, Subcontractor Hours, or Consultant Hours subtasks in any of the above
applications, you can assign hours directly to a labor category by selecting either GLC or PLC from the ID Type drop-

down list.

Project Select > Staff Hours
Project ID: 2300.0000.9999.9999 Type: BUD Version: 1 Status: Working

@ ID Type ™ ID* Name * AcctID™® Org ID* GLCIPLC Hr Rate
|Employee KBD FULL TIME DIRECT LABOR 5039-100 1.1.15 None 0.00
Generic Staff A

GLCO1 T2 5039-100 1.1.15.002 T2 22.00
Key Entry
Genera, Labor CJORAL: WALDMAN, DAVID 5039-100 1.1.15.002 P4 0.00
|Project Labor Cz 001776 YUN, REGINA 5039-100 1.1.15.002 P3 0.00
= < >
q “Select- v | | | | | | 0.00|

The PLC column within these subtasks was renamed to GLC/PLC. The codes available for selection are determined by
the ID Type selected. After you select the code, you can modify the Hr Rate field as needed. The amount in the Hr Rate

field is the cost associated with the GLC/PLC.

fT ID Type * ID* Name * AcctID* OrgID * GLCIPLC HrRate Rev
—)| General Labor ( ¥ |GLC |F’ROFESSIONAL LEVEL 5039-100 |1_1_15_002 lp1 20.00 1]

Note that if the Hr Rate field defaults to zero and you do not enter a rate, revenue will not be offset by labor costs.

Prior to this enhancement, the cost (Hr Rate) of the resource (for example, employee, subcontractor, or consultant) was
already established, so revenue was automatically offset by cost within the budget.
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To help you manage GLC and PLC rates, two new applications have also been added to Budgeting & Planning.

Manage Cost Rates

To establish PLC and GLC rates outside of the budgeting application, use the following screens:
= Planning » Project Budgeting » Controls and Utilities » Manage Average Cost GLC Rates
= Planning » Project Budgeting » Controls and Utilities » Manage Average Cost PLC Rates

Note that these are existing Costpoint screens (Projects » Advanced Project Budget Controls) which were added to
the Budgeting & Planning menu structure, so though technically not new, they are new within Budgeting & Planning.

These “new” screens are used to add or edit cost rates for an existing GLC or PLC. When that GLC or PLC is selected
in a budgeting application, the rate automatically populates the HR Rate field. However, since that field remains
editable, the rate can still be modified from within the budgeting application.

To learn more about these screens, see the following in the online Help:

¢ Manage Average Cost GLC Rates

e Manage Average Cost PLC Rates

Project Labor Category Subtask Updates
Other changes related to this feature were applied to the Project Labor Categories subtask, including the following:

= To improve usability, the subtask link now displays directly on the Project Budgets/EACs screen. It was
previously located on the Revenue Setup/Ceilings subtask.

=  Column labels were updated as follows:
= Link to Accounting System PLC label was changed to Link to Project PLC.
= Accounting PLC was changed to Project PLC.

= Accounting PLC Description was changed Project PLC Description.
Labor Report Updates

Project Budgeting reports are currently in the process of being updated to include labor hours budgeted by GLC or PLC.
For this current release, the Revenue Analysis (BPAL17) report was updated. Additional, reports will be updated in future
releases.

EACCT Table Updated with Account Name Details During Refresh

During the refresh process, the EACCT table is now updated with Account Name details, enabling use of this
information in Costpoint Enterprise Reporting.
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Time
There are no updates to this area.

Expense

Expense Authorization Attachment Subtask Conversion

To improve usability, the Attachment subtask in Manage Expense Authorization and Manage/Approve Expense

Authorizations was converted to a tab.

GEAEN0OD 8HE OOCNOEOA&

% [0 Browse Applications > Time & Expense = Expense > Expense Authorizations >

Manage Expense Authorization

Manage Expense Authorization

M| o 2030 Existing b MO— (X

Auth ID EAO0000106 Description | Add Charges to ER When Created Revision 0 Estimated Costs 45.00
Date 06/19/2018 Currency usbh
Status Processed
Purpose  Locations  Default Charges m Details  Workflow
New Query W
v Description Attachment Type * Reason for missing Receipt File Name
4 »

Upload Attachment ] View Attachment ]

Planned Expenses 1 of 1 Existing O—
Auth 1D EAD0000106 Description Add Charges to ER When Created Auth Start 06/19/2018 Auth End 06/19/2018
Expense ID 1 Expense Type Taxi Expense Date Estimate 45.00

Details _ Charge Allocations n EME
New Cuery ¥
e Description Attachment Type * Reason for Missing Receipt File Name
4 »

Upload Attachment ] View Attachment ]

Prior to this change, the Attachments displayed as subtask link, as shown below:

D EAD0000046

Employee (10010 Pasternak, Laura D.

Type ™ Long Distance - Government

From * 037282016 ":'| [ First Day of Trip
To* 032822016 [ [ Last Day of Trip
Purpase Abbeville QTF national sales conference|
Suhmlil

Date * (03282016 [
Status [Submitted

Revision History  Charge mstrlbmiunWMtﬂow

This enhancement was applied to Manage Expense Authorization and Manage/Approve Expense Authorizations.

Expense Report Attachment Subtask Conversion

To improve usability, the Attachment subtask in Manage Expense Report and Manage/Approve Expense Reports was
converted to a tab. This change also supports the upcoming Expense Wizard, scheduled for release later in 2018.
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(S|~ OOCNOREAOE

W [i] Browse Applications > Time & Expense > Expense > Expense Reports > Manage Expense Report

Manage Expense Report 1 of 53 Exdisting ‘ > | ] D|_‘ X ‘
ReportID |ER00000304 Description  changing default changes back Revision 1 Total To Me 20,125.00
Date 07/12/2018 Correction 0 Payment Received 0.00
Status Submitted Batch ID Currency ushD

Purpose  Locations _ Default Charges  Details  Workflow

[ v
v Description Attachment Type * Missing Receipt Reason for missing Receipt File Name
4 w >
Upload Attachment I View Attachment ]
Claimed Expenses 1 of 3 Existing ‘ » | 3] D|_
ReportID  ER0O000D0304 Description changing default changes back Report Start  07/12/2018 Report End 07122018
Expense ID 1 Expense Type Mileage - International Expense Date (07/12/2018 Expense Amount 18,880.00

Details  Details (Other)  Amount

New ‘ Quey ¥ ‘

Description Attachment Type * Missing Receipt Reason for Missing Receipt File Name

[&
4 " »

Upload Attachment ] View Attachment ]

Prior to this change, the Attachments displayed as subtask link, as shown below:

Type* Infernational - Govemnment usp
Authorization Launch] ) [] Close Blankst Total Expenses 1g$
-| Company Paid 1
Fiom* Ca2B2076 |3 e =
- . — [] Advance
o B02016 Ji Code 1 [1234567B9012345674
- [ Personal 6.00
Furpose Union Jack Chent conference Code2 [TESTI3 e
Code3 [TESTH [-] Mon-Reimbursable
[] Payment Received 0.00
Submif]  Comect] Total Amount Du 1o Employee 46.00
Gillable  Chorge Distribution  Company Paid  Mon Reimbursable  Paymen!  Bevision History ’wﬂd\ml“s
Category View B Workfiow
ly# Claimed Expenses [ e | [ Dasetn 1602 Exsting [RITIRES O[—

Amcunt | Room Rates | Taxes | Other Lodging Expenses

1D} 1| Category Lodging | F;tggm Per Diem Lodging
Location LONDON,UNITED KINGDOM
Expense Date b3a02016 oA Checkein Date 03282016 [
Provider ) Check-Out Date 032972016 [9
Short Description ERO00D0081 | LODGINGPD | 2016-03- [ Humber of Hights 1 A Late Check ot
inerary
Comments. Bm rate incls comp Guinness

Agreement Numbes

Per Diem Rates  Chame Allocations Under Cailing  Charoe Allocations Over Ceiling  Charne mlummn

This enhancement was applied to Manage Expense Report and Manage/Approve Expense Reports.

Expense Report Workflow Moved to Tab

The Workflow subtask on Expense » Expense Report » Manage Expense Reports screen has been reconfigured as
a tab for easier access. On new expense reports, the Workflow tab does not display until the expense report is saved.

Purpose  Default Charges  Details  Void

iFurm:Query "I

. Sequence Primary Role Task Task Item Expense/Charge = Amount Currency Rule Status Rejection/Missing Reason (Can be) Completed By
0|Employee |Create |0verall ‘ | | ‘Required Completed |Pine Jr., Nuts (EXPSUP1)  Monday, Jun 1
1 Employee Submit Overall Required Pending

Upload Attachment File | View Attachment | _Attachment Missing |

Expense Authorization Workflow Moved to Tab
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The Workflow subtask on Expense » Expense Authorization » Manage Expense Authorization screen has been
reconfigured as a tab for easier access. On new expense reports, the Workflow tab does not display until the expense
authorization is saved.

Purpose  Locations  Default Charges  Details  Void

Form | Query W

Sequence Area Primary Role Task Task Item Expense/Charge Amount Currency Rule Status Rejection/Missing Reason (Can be) Completed B
0|Authorization Employee ‘Create ‘Overall ‘ | ‘ |Required Completed Pine Jr., Nuts (EXPSUP1) Tl

1 Authorization Employee Submit Overall Required Pending
< w [S

Expense Report Per Diem Rates Now Display as Pop-ups

Per Diem rates now display in a pop-up window on the Expense Report Locations tab. The pop-up displays the rates
before and after you save while in the normal Costpoint layout and also in Wizard mode after you select the location.

M Default Charges  Details  Void  Workflow

New | Delete | Form | Query W

= Seq Location * Start Date * End Date * State * City * ﬁDiem mmjve Frequent Location Comment

| 1|ovERLAND PARK, KANSAS  [06n9mo13  [H[oe42018  [H|KaNsAs [OVERLAND PARK  \_|View /™| |

—

Expense Authorization Per Diem Rates Now Display as Pop-ups

Per Diem rates now display in a separate pop-up window when you click the View link in the Per Diem Rates column on
the Expense Authorization Locations tab.

M Default Charges  Details  Void  Workflow

Mew | Delets | Form | Query W

n Seq Location * Start Date * End Date * State * City * /ﬁDiem mmve Frequent Location Comment

| 1|oveRLanD PARK ransas  [osroo1s  [H|osrzamois  H|kansas [OVERLAND PARK  \_|View = |

Expense Report Purpose Field Enlarged

The vertical size of Purpose field of the Expense » Expense Reports » Manage Expense Report screen was
increased to allow at least four lines of text.
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Delte

Know more.
Do more.*

Manage Expense Report

1D |[ER00DO0055 Description®  [CP Pizza
Date™  [03/28/2018
Status  [Processed

Default Charges | Details |

Employee (101049 ]  [Fisher, ArthurR
Type * [Non-Travel )
Authorization Launch | |
From * @200
To* [03/27/2018
Purpose * Plzzd 10 i
interns and team
Submit | Correct |

Billabl

Expense Authorization Purpose Field Enlarged

The vertical size of Purpose field of the Expense » Expense Authorizations » Manage Expense Authorization

screen was increased to allow at least four line of text.

=» Manage Expense Authorization

D [ Description® |
(05/31/2018

Status  |Draft

Date ®

Locations | Default Charges | Details |

Employee (101049 ) [Fisher, Arthur R.
Type * [Travel ]

From* (05/31/2018 5] [ First Day of Trip

To* ( [« Last Day of Trip

Purpose * |

Submit |

|
Configuration

There are no updates to this area.
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Deltek is the leading global provider of enterprise software and information solutions for government
contractors, professional services firms and other project- and people-based businesses. For decades, we
have delivered actionable insight that empowers our customers to unlock their business potential. 20,000
organizations and millions of users in over 80 countries around the world rely on Deltek to research and identify
opportunities, win new business, recruit and develop talent, optimize resources, streamline operations and deliver
more profitable projects. Deltek — Know more. Do more.®

deltek.com

Know more.
www.deltek.com De Ite Do more™
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